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Introdução

Agradecemos-lhe ter escolhido a Medtronic Diabetes como seu aliado para o ajudar a si e aos

seus doentes na tarefa de melhor gerir a terapia da diabetes. Acreditamos que colherá vantagens

da tecnologia de ponta do software CareLink® Pro e do respetivo interface de utilizador simples,

com base numa estrutura de menus.

O CareLink Pro permite-lhe captar, guardar e elaborar relatórios dos dados de diagnóstico e

tratamento dos doentes. Também pode utilizá-lo para aceder aos dados da bomba de insulina,

do medidor e da glicose registada pelo sensor que os seus doentes enviaram para o CareLink®

Personal, um sistema de gestão da terapia com base na Web que funciona em conjunto com o

CareLink Pro.

Funções

O CareLink Pro é um software de gestão da terapia da diabetes para instalar num computador

pessoal (PC). Integra as seguintes funções:

• Podem ser criados registos do doente para guardar os dados recolhidos do dispositivo do

doente, além dos dados da terapia da sua conta CareLink Personal.

• Podem ser enviados dados das bombas de insulina, monitores e medidores de glicose no

sangue para o sistema, onde são guardados e usados para elaborar relatórios.

• Como característica opcional, é possível efetuar uma ligação ao sistema CareLink Personal

para aceder aos dados do dispositivo que o doente aí tiver guardado. Esta é a forma ideal de

criar relatórios atualizados entre consultas, podendo eliminar a necessidade de ler os dados

do dispositivo durante as consultas.

• Podem ser criados diferentes relatórios de tratamento a partir dos dados do dispositivo

guardados no registo do doente. Os relatórios facilitam as respostas às preocupações com a

terapia, como por exemplo, a adesão do doente, os padrões e exceções.

• O sistema alerta-o quando existem atualizações do software para transferir e instalar no

computador. Deste modo, tem sempre acesso às funções mais recentes.
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• A função Guide Me (Orientação) ajuda os utilizadores inexperientes do CareLink Pro. Fornece

indicações e sugestões acerca das tarefas que estão a realizar.

• Está disponível um sistema de ajuda integrada no software para facultar informações sobre

áreas de interesse específicas.

Segurança

• O CareLink Pro pode ser protegido com palavra-passe.

• A transmissão de dados do doente a partir do CareLink Personal é encriptada pela tecnologia

de referência Secure Sockets Layer (SSL).

Documentos relacionados

Cada um destes documentos da Medtronic MiniMed contém informações específicas de cada

dispositivo que não são tratadas em pormenor neste guia do utilizador.

NOTA: Para informações específicas sobre medidores, consulte as instruções do fabricante

que acompanham o medidor.

• Guia do utilizador da bomba de insulina Paradigm

• Guia do utilizador do monitor Guardian REAL-Time

• Guia do utilizador das funções do sensor

• Guia do utilizador ComLink

• Guia do utilizador CareLink USB

Assistência

Se precisar de ajuda adicional com este sistema, contacte o seu representante local. Aceda ao

seguinte site de Internet para consultar os contactos internacionais:

http://www.minimed.com/contact/international-locations

Dispositivos suportados

O CareLink Pro recolhe os dados dos seguintes dispositivos.

NOTA: Alguns dispositivos suportados por este software podem não estar disponíveis em
todos os países em que a utilização deste software está aprovada.
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Bombas de insulina/Monitores de glicose

Bombas de insulina Medtronic MiniMed: 508

Bombas de insulina da série Paradigm® da Medtronic
MiniMed:

511, 512, 712, 515, 715, 522, 722, 522K, 722K,
Paradigm® Veo™ (554, 754)

Monitores Guardian REAL-Time:
CSS-7100

CSS-7100K

Fabricante Medidores de glicose no sangue

Medidores conectados:
• Bayer's CONTOUR® LINK

• Monitor de glicose no sangue BD Paradigm Link®

Bayer:

• CONTOUR® USB

• Ascensia BREEZE®

• BREEZE® 2

• CONTOUR®

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini®

• OneTouch® UltraEasy®

BD: • Logic®

Família Bayer Ascensia™ DEX™, incluindo estes
medidores compatíveis:

• Ascensia™ DEX™

• Ascensia™ DEX™ 2

• Ascensia™ DEXTER-Z® II

• Glucometer™ DEXTER-Z®

• Ascensia™ ESPRIT® 2

• Glucometer™ ESPRIT®

• Glucometer™ ESPRIT® 2

Família Bayer Ascensia™ ELITE™, incluindo estes
medidores compatíveis:

• Ascensia™ ELITE™

• Glucometer™ ELITE™ XL
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Fabricante Medidores de glicose no sangue

Abbott:

• FreeStyle®

• FreeStyle® Lite®

• FreeStyle® Freedom®

• FreeStyle® Freedom Lite®

• Precision Xtra®

• TheraSense FreeStyle®

• FreeStyle® Flash®

• FreeStyle® Papillon™ mini

• FreeStyle® Mini®

• Optium Xceed™

• Precision Xceed™

Roche:

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active

Dispositivos de comunicação

CareLink® USB Para usar com a bomba de insulina MiniMed da série
Paradigm e com o monitor Guardian REAL-Time.

Monitor de glicose no sangue Paradigm Link®

Para usar com uma bomba de insulina MiniMed
Paradigm ou com o monitor Guardian REAL-Time
(consulte o guia do utilizador do monitor de glicose
no sangue Paradigm Link® para mais pormenores
sobre o hardware necessário).

ComLink

Para usar com a bomba de insulina MiniMed Paradigm
e com o monitor Guardian REAL-Time (consulte o guia
do utilizador ComLink para mais pormenores sobre o
hardware necessário).

Com-Station

Para usar com a bomba de insulina Medtronic
MiniMed 508 (consulte o guia do utilizador Com-
-Station para mais pormenores sobre o hardware
necessário).

Cabo de comunicação de dados

Para usar com medidores de glicose no sangue de
outros fabricantes. Cada fabricante de medidores
fornece um cabo de comunicação de dados.

Nota: Se um fabricante de medidores fornecer um
cabo USB em vez de um cabo série para envio de
dados, é necessário instalar o controlador de software
fornecido por esse fabricante.

Informe-se igualmente junto do fabricante do medidor
para garantir que o controlador USB é compatível com
o seu sistema operativo. Alguns controladores USB
poderão não estar disponíveis para sistemas
operativos de 64 bits.

Dispositivos equivalentes

Quando adiciona um dispositivo ao sistema, deve selecionar a respetiva marca e modelo numa

lista. Se a marca e modelo de um dispositivo não se encontrarem na lista, consulte a seguinte

tabela para descobrir um dispositivo equivalente que possa usar.
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Se o seu doente usar um destes dispositivos Selecione este dispositivo

• Ascensia™ DEX™ 2 da Bayer

• Ascensia™ DEXTER-Z™ II da Bayer

• Glucometer™ DEXTER-Z™ da Bayer

• Ascensia™ ESPRIT® 2 da Bayer

• Glucometer™ ESPRIT® da Bayer

• Glucometer™ ESPRIT® 2 da Bayer

Ascensia™ DEX™ da Bayer

Glucometer™ ELITE™ XL da Bayer Ascensia™ ELITE™ da Bayer

Precision Xceed™ Optium Xceed™

Encomendar

Para encomendar produtos Medtronic Diabetes, contacte o seu representante local. Aceda ao

seguinte URL para consultar os dados internacionais de contacto:

http://www.medtronicdiabetes.com/help/contact/locations.html

NOTA: Os medidores podem ser encomendados às empresas que os fabricam.

Como utilizar este guia

NOTA: Este guia do utilizador mostra apenas ecrãs exemplificativos do software. Os ecrãs
reais do software podem ser ligeiramente diferentes.

Consulte o Glossário para obter as definições dos termos utilizados e das funções da bomba de

insulina. Os termos e símbolos utilizados neste guia encontram-se na tabela seguinte.

Termo / símbolo Significado

Clicar Premir o botão esquerdo do rato sobre um objeto no
ecrã para o selecionar.

Fazer duplo clique Premir duas vezes o botão esquerdo do rato sobre um
objeto no ecrã para o abrir.

Clicar com o botão direito do rato Premir o botão direito do rato sobre um objeto no
ecrã para visualizar outra janela ou menu.

Texto a negrito
Utilizado para um botão, nome de ecrã, nome de
campo ou opção de menu. Por exemplo: Patient >
New Patient (Doente > Novo doente)

NOTA: 
Fornece informações adicionais sobre um
procedimento ou passo.

ATENÇÃO:
Avisa de um potencial perigo que, caso não seja
evitado, pode resultar em danos ligeiros a moderados
no equipamento ou programa de software.

AVISO:
Notifica-o de um possível perigo que, caso não seja
evitado, pode resultar em morte ou ferimentos graves.
Pode ainda descrever possíveis reações adversas
graves e perigos para a segurança.
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Segurança do utilizador

Indicações de utilização

O sistema CareLink Pro destina-se a ser utilizado como ferramenta auxiliar na gestão da diabetes.

A finalidade deste sistema é transformar em relatórios CareLink Pro a informação recebida de

bombas de insulina, medidores de glicose no sangue e sistema de monitorização contínua de

glicose. Os relatórios fornecem informação que pode ser usada para identificar tendências e

acompanhar atividades diárias — como os hidratos de carbono ingeridos, as horas das refeições,

a administração de insulina e as leituras de glicose.

Avisos

• Este sistema destina-se a ser usado por um médico familiarizado com a gestão da

diabetes.

• Os resultados do sistema não se destinam a produzir aconselhamento médico e não devem

constituir a base do mesmo.

• Este produto deve apenas ser usado com os dispositivos suportados que são enumerados

neste documento (Consulte Dispositivos suportados na página 2).

• Os doentes devem ser aconselhados a monitorizar os seus níveis de glicose no sangue pelo

menos 4–6 vezes ao dia.

• Os doentes devem ser aconselhados a não alterar o tratamento sem consultarem o seu

médico.

• Os doentes devem ser aconselhados a tomar decisões de tratamento com base nas

orientações do médico e nos resultados do medidor de glicose no sangue e não nos

resultados do sensor de glicose.
 
Contraindicações

Este software não deve ser usado com dispositivos que não estejam incluídos na lista de

Dispositivos suportados na página 2.  Este produto não deve ser usado para tratar outras condições

médicas para além da diabetes.

Antes de abrir este software, encerre qualquer um dos seguintes programas de software que

possam estar a ser executados no computador:

• Software Solutions™ para o sistema CGMS® (7310)

• Software para medidores e bombas de insulina Solutions® (7311)

• Software Guardian® Solutions® (7315)

• ParadigmPAL™ (7330)

• Software CareLink® Personal (7333)

• Software Solutions® para CGMS®iPro (7319)
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2

Primeiros passos

As informações a seguir apresentadas orientam-no ao longo do processo de início do software

CareLink Pro, abrir e fechar os registos dos doentes e configurar as preferências a aplicar a todos

os doentes do sistema.

Antes de começar

Se está a utilizar o CareLink Pro pela primeira vez, assegure-se de que configura as preferências

gerais (consulte Preferências gerais na página 12). Estas preferências determinam a forma como

certos itens são visualizados no software e nos relatórios e como o sistema vai comunicar com a

Internet.

As preferências podem ser configuradas em qualquer altura. É aconselhável aguardar até que

esteja familiarizado com o software CareLink Pro antes de configurar as outras preferências.

Principais tarefas do sistema

A tabela seguinte contém as principais tarefas que deve executar da primeira vez que configurar

e utilizar o CareLink Pro. Indica-lhe ainda a parte deste guia do utilizador na qual se aborda cada

uma das tarefas.

Etapa Localização

Familiarizar-se com a interface do utilizador do
CareLink Pro. Navegar no sistema na página 8

Definir as opções globais do sistema que a sua
instituição de saúde utiliza. Configurar as preferências do sistema na página 11

Criar perfis para cada um dos doentes. Adicionar novos perfis na página 20

Efetuar a ligação às contas do CareLink Personal dos
seus doentes. Efetuar ligação ao CareLink Personal na página 21

Adicionar a bomba de insulina e medidores dos
doentes ao respetivo perfil. Adicionar um dispositivo na página 28

Ler os dados da bomba de insulina e medidores dos
doentes. Ler dados do dispositivo na página 34
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Etapa Localização

Configurar e elaborar relatórios para cada um dos
doentes. Criação de relatórios na página 37

Efetuar regularmente cópias de segurança da base de
dados do CareLink Pro.

Efetuar cópias de segurança da base de dados na
página 48

Atualizar o software CareLink Pro. Aplicar atualizações de software na página 47

Navegar no sistema

Antes de trabalhar com o software CareLink Pro, deve familiarizar-se com a interface do utilizador.

A interface do utilizador inclui menus, uma barra de ferramentas, uma barra de navegação, áreas

de trabalho e uma janela Guide Me (Orientação).

Abertura do CareLink Pro

1 Faça duplo clique no ícone CareLink Pro  no ambiente de trabalho do computador ou

selecione Medtronic CareLink Pro  na lista de Programas do menu Iniciar do Windows.

Se a sua instituição de saúde exigir que introduza uma palavra-passe, aparecerá um ecrã de

início da sessão.

a. Digite a sua palavra-passe no campo Password  (Palavra-passe).

NOTA: A introdução de uma palavra-passe é uma função opcional configurada
durante o processo de instalação.

b. Clique em LOGIN (Iniciar sessão).

Surge o ecrã de arranque.

2 Para iniciar um novo registo de doente, clique em New Patient  (Novo doente). Para abrir um

registo de doente a partir de uma lista de doentes existente no sistema, clique em Open
Patient  (Abrir doente).

Áreas de trabalho

Se tiver o registo de um doente aberto, pode clicar num dos botões da barra de navegação para

visualizar a área de trabalho correspondente. Use estas áreas de trabalho para introduzir ou

selecionar informações de modo a efetuar tarefas do CareLink Pro para esse doente.

Profile (Perfil): Permite-lhe conservar os dados do
doente guardados, como por exemplo, o nome e a
data de nascimento. Esta área de trabalho permite-lhe
ainda efetuar a ligação à conta CareLink Personal de
um doente.

Devices (Dispositivos): Permite-lhe guardar as
informações necessárias para ler os dispositivos de um
doente.

Reports (Relatórios): Permite-lhe selecionar
parâmetros e escolher os relatórios a elaborar para o
doente.
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Até ser adicionado e guardado o perfil de um doente, apenas a área de trabalho de Profile (Perfil)

está acessível para esse doente. Até serem adicionados os dispositivos de um doente, apenas as

áreas de trabalho de Profile (Perfil) e Devices (Dispositivos) estão acessíveis para esse doente.

Barra de ferramentas

A barra de ferramentas do CareLink Pro fornece um acesso rápido às funções frequentemente

usadas. A barra de ferramentas contém os seguintes botões.

Botão Nome Functionality (Funcionalidade)

Add Patient (Adicionar doente)

Abre uma área de trabalho de
Profile (Perfil) para que possa
acrescentar o registo de um novo
doente ao sistema.

Open Patient (Abrir doente)

Abre a tabela Patient Lookup
(Localização de doentes) na qual
pode escolher um registo de
doente existente para visualizar.

Guide Me (Orientação)

Mostra ou oculta a janela Guide
Me (Orientação). Clique para obter
sugestões do sistema associadas ao
contexto.

Separadores do doente

Ao abrir o registo de um doente, surge um separador ao longo da barra de ferramentas com o

nome do doente. Quando o separador está ativo, o registo do doente e a área de trabalho estão

ativos, sendo possível executar tarefas do CareLink Pro para esse doente.

Para ativar um registo de doente para que possa trabalhar com o mesmo, clique no separador

relativo a esse doente. Para fechar um registo de doente, clique no botão Close  (Fechar)  no

separador.

A função Guide Me (Orientação)

A função Guide Me (Orientação) está sempre presente no CareLink Pro. Abre uma janela com

indicações e sugestões do sistema associadas ao contexto, sobre ações que pode realizar a partir

do ponto do sistema que se encontra ativo. As janelas Guide Me (Orientação) podem incluir ainda
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hiperligações >>learn more  (Saber mais). Ao clicar nestas hiperligações, é conduzido até à secção

associada da ajuda online, para mais pormenores. A função Guide Me (Orientação) está

normalmente ativada. No entanto, é possível desativá-la a qualquer altura.

Ativar e desativar a função Guide Me (Orientação)

Para ativar ou desativar a função Guide Me (Orientação), proceda da seguinte forma:

• Clique no botão Guide Me  (Orientação). 

• Selecione Help (Ajuda) > Guide Me  (Orientação).

Abrir registos de doentes

É possível abrir um máximo de seis registos de doentes em simultâneo. Se ainda não tiver

criado quaisquer perfis de doentes, consulte Adicionar novos perfis na página 20.

1 Selecione File > Open Patient (Ficheiro > Abrir doente) ou clique no botão Open Patient

(Abrir doente).  É visualizada uma lista de doentes semelhante à seguinte.
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NOTA: Se receber uma mensagem indicando que estão abertos demasiados registos de
doentes, clique em OK, feche um registo e continue.

2 Localize a lista de doentes digitando parcial ou integralmente o seu nome no campo Find a
Patient  (Localizar um doente). Quando a lista de doentes aparecer realçada, clique em OPEN
(Abrir), faça duplo clique sobre a lista ou prima ENTER. Pode ainda navegar na lista, usando as

setas ascendente e descendente do teclado.

Surge a área de trabalho Devices (Dispositivos) (se os dispositivos ainda não tiverem sido

acrescentados) ou Reports  (Relatórios) do doente.

3 Para ver a área de trabalho Profile  (Perfil) do doente, clique no botão Profile  (Perfil) 

na barra de navegação.

Fechar registos de doentes

1 Assegure-se de que o registo do doente que pretende fechar está ativo (separador

realçado).

2 Efetue uma das seguintes ações:

a. Selecione File > Close Patient (Ficheiro > Fechar doente).

b. Clique no botão Close  (Fechar)  no separador do doente.

c. Prima Ctrl+F4.

Configurar as preferências do sistema

Estas preferências aplicam-se a todos os doentes do sistema. Para saber mais sobre as

preferências que se aplicam apenas a doentes individuais, consulte Verificação das configurações

dos relatórios na página 40.

As preferências apresentam-se divididas pelos seguintes grupos:

• General (Gerais)

- Glucose units (Unidades de glicose)

- Carbohydrate units (Unidades de hidratos de carbono)

- Communications (Comunicações)

- Troubleshooting

• Patient Profile (Perfil do doente)

- Selecione e disponha os campos de dados nos perfis dos doentes.

• Patient Lookup (Localização de doentes)

- Modifique e altere a ordem dos campos visualizados quando seleciona Open Patient

(Abrir doentes) para ver uma lista de doentes.

• Report Generation (Criação de relatórios)

- Escolha os campos de dados que pretende visualizar ao selecionar na Data Table (Tabela

de dados) os elementos que devem figurar no relatório Daily Detail (Diário exaustivo).
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Preferências gerais

Utilize o separador General (Geral) para definir a forma como o software apresenta

determinados tipos de informações, bem como para estabelecer as suas preferências de

comunicação externa.

1 Se ainda não estiver ativo, clique no separador General (Geral).

2 Selecione Tools > Options  (Ferramentas > Opções). Surge a janela seguinte.

3 Clique para selecionar o botão de opção relativo ao valor que pretende:

- Glucose Units  (Unidades de glicose): mg/dl ou mmol/l

- Carbohydrate Units  (Unidades de hidratos de carbono): grams ou Exchanges (gramas

ou porções)

a. Se tiver selecionado Exchanges  (Porções) como Carbohydrate Units  (Unidades de

hidratos de carbono), digite o número adequado no campo grams are equal to 1
Exchange  (gramas equivalem a 1 porção).

4 Clique para selecionar ou limpar a caixa de verificação na secção Chart Options > Overview

Report (Opções de tabela > Vista geral). Se a caixa de verificação estiver selecionada, a

aplicação irá associar as leituras de GS do quadro Meter Glucose Overlay (Sobreposição de

glicose do medidor) a linhas (trata-se de um quadro apresentado no relatório Perspetiva

geral do sensor e medidor de glicose).

5 Nas seguintes preferências de Communications (Comunicações), clique para selecionar a

caixa de verificação (ativar) ou para limpar a caixa de verificação (desativar):

NOTA: Assegure-se de que respeita as diretrizes da sua instituição de saúde ou
departamento de TI ao configurar as preferências de comunicação.
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- Automatically check for software updates (Verificar automaticamente a existência
de atualizações de software):  se for selecionada, será enviada uma notificação a cada

sistema que estiver a executar o CareLink Pro, sempre que ficar disponível uma

atualização do software. O utilizador ativo terá então a oportunidade de transferir e

instalar as atualizações. Para evitar que tal aconteça e para instituir uma distribuição

controlada das atualizações do software, pode limpar esta caixa de verificação.

- Synchronize with Medtronic CareLink® Personal (Sincronizar com o CareLink®
Personal da Medtronic):  Se pretender que o sistema efetue automaticamente a

sincronização com os dados do doente no CareLink Personal, de cada vez que abrir o

respetivo perfil, selecione esta caixa de verificação. Se limpar esta caixa de verificação,

terá de sincronizar manualmente os dados do CareLink Personal de cada doente.

6 Clique para selecionar ou limpar a caixa de verificação na secção Troubleshooting
(Resolução de problemas). Se a caixa de verificação for selecionada, a aplicação guardará um

registo das leituras do dispositivo para a resolução de problemas.

7 Clique em OK para guardar as preferências gerais.

Patient profile preferences (Preferências do perfil do doente)

Trata-se de uma configuração global que define o conteúdo dos perfis. Pode personalizar campos

na área de trabalho Profiles (Perfis) de forma a incluir informações de maior relevância para a sua

instituição de saúde. Pode adicionar ou remover campos, criar os seus próprios campos

personalizados e determinar a ordem pela qual os campos aparecerão na janela.

1 Selecione Tools > Options  (Ferramentas > Opções).

2 Clique no separador Patient Profile  (Perfil do doente). Surge a janela seguinte.

NOTA: Use as caixas de verificação para escolher os campos que pretende ter no perfil.
Use os botões com setas ascendente e descendente para colocar os campos em ordem.
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Escolher campos de dados

1 Use as caixas de verificação para adicionar os campos que pretende.

NOTA: Os campos de First Name e Last Name (Nome e apelido) não podem ser
removidos.

2 Para retirar um campo de um perfil, limpe a respetiva caixa de verificação.

3 Para fazer com que um campo seja de preenchimento obrigatório, selecione a caixa de

verificação da coluna Required (Obrigatório). Este tipo de campo tem obrigatoriamente de

ser preenchido para que possa ser criado um perfil.

Adicionar um campo personalizado

1 Selecione a caixa de verificação à esquerda de um campo personalizado vazio.

2 Digite o texto para atribuir um nome ao campo (por exemplo, Emergency Contact (Contacto

de emergência)). Este é o nome de campo que aparecerá no perfil do doente.

3 Para fazer com que o campo seja de preenchimento obrigatório, selecione a caixa de

verificação da coluna Required (Obrigatório).

NOTA: Para retirar um campo personalizado do perfil, limpe a caixa de verificação ao
lado do(s) campo(s) que pretende remover.

Alterar a ordem dos campos de dados

Selecione o campo que pretende deslocar e clique na seta ascendente ou descendente  para

o deslocar (as setas nas partes superior ou inferior deslocam o campo para o topo ou para o

fundo da lista).

Finalizar as preferências do perfil do doente

Quando a lista Field Order (Ordem dos campos) tiver todos os campos pretendidos na ordem

correta, clique em OK.

Os perfis dos doentes apresentam agora os campos e a ordem dos campos que acabou de

selecionar.

Preferências de Patient Lookup (Localização de doentes)

A tabela Patient Lookup (Localização de doentes) é utilizada para pesquisar e abrir um registo

de doente. A tabela inclui todos os doentes existentes na base de dados e fornece

informações de identificação a partir do perfil do doente. Dispõe da opção de personalizar as

informações que são apresentadas nesta tabela, bem como a ordem pela qual as colunas

aparecem. Para personalizar a tabela Patient Lookup (Localização de doentes), proceda da

seguinte forma:

1 Selecione Tools > Options  (Ferramentas > Opções).
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2 Clique no separador Patient Lookup  (Localização de doentes). Surge a janela seguinte.

NOTA: Use as caixas de verificação para escolher os dados que pretende ter na tabela

Patient Lookup (Localização de doentes). Use os botões com setas ascendente e
descendente para colocar as colunas em ordem.

Escolher dados para visualizar

Use as caixas de verificação para selecionar o tipo de dados que pretende visualizar ou para

apagar os dados que não pretende visualizar na tabela Patient Lookup (Localização de

doentes).

Alterar a ordem das colunas

Para alterar a ordem das colunas na tabela Patient Lookup (Localização de doentes), selecione a

coluna a deslocar e clique nas setas ascendente ou descendente  (as setas nas partes superior

ou inferior deslocam uma coluna de dados para o topo ou para o fundo da lista).

A coluna de dados no topo da lista Column Display Order (Ordem de visualização das colunas)

aparecerá na primeira coluna da tabela Patient Lookup (Localização de doentes). A coluna de

dados ao fundo será visualizada na última coluna da tabela.

Finalização das preferências de Patient Lookup (Localização de doentes)

Quando a lista Column Display Order (Ordem de visualização das colunas) tiver todos os dados

pretendidos na ordem correta, clique em OK.

A tabela Patient Lookup (Localização de doentes) apresenta agora todos os dados e colunas na

ordem que acabou de selecionar.
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Preferências de Report Generation (Criação de relatórios)

A Data Table (Tabela de dados) surge na janela Select and Generate Reports (Selecionar e

gerar relatórios). Esta tabela é utilizada durante a elaboração de relatórios. Contém

informações diárias derivadas dos dispositivos do doente e, caso seja aplicável, da respetiva

conta do software CareLink Personal. Os dados fornecidos nesta tabela ajudam a determinar

quais os dias que requerem um relatório Daily Detail (Diário exaustivo). Ajuda também a

decidir quais os restantes relatórios a elaborar.

A sua instituição de saúde pode personalizar os dados que são apresentados nesta tabela,

incluindo a ordem pela qual são apresentados, de forma a refletir o que é mais relevante para

a sua instituição.

NOTA: Para ver como estas preferências se aplicam à Data Table (Tabela de dados) durante
a criação de um relatório, consulte Seleção de tipos de relatórios e datas de inclusão na

página 42.

1 Selecione Tools > Options  (Ferramentas > Opções).

2 Clique no separador Report Generation  (Criação de relatórios). Surge a janela seguinte.

Escolher dados para visualizar

Use as caixas de verificação para selecionar o tipo de dados que pretende visualizar ou para

apagar os dados que não pretende visualizar na Data Table (Tabela de dados).

As informações a seguir apresentadas estão disponíveis para inclusão na Data Table (Tabela de

dados).
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Nome da coluna Definição

№ of Meter Readings (N.º de leituras do medidor) A quantidade de leituras, relativas à data especificada,
que foram gravadas pelos dispositivos incluídos.

Meter Readings Average (Média de leituras do
medidor)

A média das leituras de glicose gravadas pelos
dispositivos incluídos.

Sensor Duration (Duração do sensor)
A quantidade de tempo dentro da data especificada
para a qual foi gravada a data do sensor. Os valores
são -- (nenhum), 0:05 - 24:00.

Sensor Average (Média do sensor) A média de leituras do sensor gravada na data
especificada.

Highest Reading (Leitura mais alta) A leitura de glicose mais alta (derivada de um sensor
ou medidor) relativa à data.

Lowest Reading (Leitura mais baixa) A leitura de glicose mais baixa (derivada de um sensor
ou medidor) relativa à data.

Avg AUC Below Target (AUC méd. abaixo do objetivo) Área média por baixo da curva abaixo do objetivo do
doente.

Avg AUC Above Target (AUC méd. acima do objetivo) Área média por baixo da curva acima do objetivo do
doente.

Total Carbs (Total de hidratos de carbono)

A soma de todas as quantidades de hidratos de
carbono (arredondada para o grama ou para a porção
0,1 mais próxima, dependendo da unidade de medida
usada) registadas durante o dia através de eventos de
Bolus Wizard (Ajuda de bolus) ou de marcadores de
hidratos de carbono na bomba de insulina ou no
monitor Guardian.

Suspend Duration (Duração da suspensão)
A quantidade de tempo de suspensão da bomba de
insulina na data especificada. Os valores são --
(nenhum), 0:01 - 24:00.

№ of Rewinds (N.º de rebobinagens) O número de eventos de rebobinagem relativo à data
especificada.

№ of Primes (or Fills) (N.º de preparações [ou
enchimentos])

O número de eventos de preparação (ou eventos de
enchimento) registado relativamente à data
especificada.

Prime (or Fill) Volume (U) (Volume de preparação [ou
enchimento] [U])

O volume total de insulina utilizada para eventos de
preparação (ou eventos de enchimento) na data
especificada.

Total Insulin (U) (Total de insulina [U])
O volume total de insulina administrada durante a
data especificada, conforme registado pela bomba de
insulina.

Total Basal (U) (Índice basal total [U])
O volume total de insulina basal administrada durante
a data especificada (o total de insulina administrada,
menos a soma de todos os bolus administrados).

Total Bolus (U) (Bolus total [U])
O volume total de insulina administrada em bolus
durante a data especificada, conforme registado pela
bomba de insulina.

Basal % (% do índice basal) Apresenta a proporção (em valores % inteiros) de
insulina basal para insulina total.

Bolus % (% de bolus) Apresenta a proporção (em valores % inteiros) de
insulina de bolus para insulina total.

№ of Boluses (N.º de bolus) O número de eventos de bolus registados
relativamente à data especificada.

Bolus Wizard Events (Eventos de Bolus Wizard) O número total de eventos de Bolus Wizard registados
relativamente à data especificada.
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Nome da coluna Definição

Bolus Wizard Overrides (Alterações de Bolus Wizard)
O número de eventos de Bolus Wizard em que a
quantidade de insulina administrada é diferente da
quantidade recomendada.

№ of Meal Boluses (N.º de bolus de refeição)
O número de eventos de Bolus Wizard com
quantidades de hidratos de carbono superiores a zero
que foram registados na data especificada.

№ of Correction Boluses (N.º de bolus de correção)
O número de eventos de Bolus Wizard com
quantidades de correção superiores a zero que foram
registados na data especificada.

№ of Manual Boluses (N.º de bolus manuais) O número de eventos de bolus, registados durante a
data, que não se trataram de eventos de Bolus Wizard.

Alterar a ordem das colunas

Para alterar a ordem das colunas na Data Table (Tabela de dados), selecione a coluna a deslocar e

clique nas setas ascendente ou descendente  (as setas nas partes superior ou inferior

deslocam uma coluna de dados para o topo ou para o fundo da lista).

NOTA: Os itens no topo da lista Column Order (Ordem das colunas) aparecerão na primeira
coluna da Data Table (Tabela de dados). Os itens ao fundo serão visualizados na última
coluna da Data Table (Tabela de dados).

Finalização das preferências para a criação de relatórios

Quando a lista Column Order (Ordem das colunas) tiver todos os dados pretendidos na ordem

correta, clique em OK.

A Data Table (Tabela de dados) apresenta agora todos os dados e colunas na ordem que acabou

de selecionar.
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3

Área de trabalho Profile (Perfil)

Um perfil é semelhante à capa de um processo de doente. Guarda os dados do doente, como o

nome e a data de nascimento. É necessário existir um perfil para que possa recolher os dados do

dispositivo e usá-los nos relatórios da terapia.

A área de trabalho Profile (Perfil) permite-lhe ainda configurar uma ligação à conta CareLink

Personal do doente. Estabelecida uma ligação, é possível recuperar em qualquer altura os dados

do doente guardados no CareLink Personal — sem que o doente esteja presente.

Antes de começar

Pode personalizar os perfis dos doentes de modo a que contenham apenas o tipo de informação

que pretende recolher. Para mais informações, consulte Patient profile preferences (Preferências do

perfil do doente) na página 13.
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É também necessário um nome de utilizador e uma palavra-passe para configurar a ligação à

conta CareLink Personal do doente. O doente tem de estar presente para facultar estes dados.

Adicionar novos perfis

De cada vez que adicionar um doente ao sistema CareLink Pro, tem de começar por preencher

um perfil para esse doente.

1 Selecione File > New Patient (Ficheiro > Novo doente) ou clique no botão Add Patient

(Adicionar doente). 

É apresentada a área de trabalho Profile  (Perfil).

NOTA: Para adicionar ou alterar campos no perfil do doente, clique em Customize fields

(Personalizar campos). Consulte Patient profile preferences (Preferências do perfil do doente)

na página 13.

2 Preencha os campos da secção Patient Profile  (Perfil do doente).

3 Clique no botão SAVE  (Guardar).

O novo perfil de doente é adicionado à base de dados do CareLink Pro. Surge uma

mensagem que confirma que o perfil foi guardado.

Preencher campos obrigatórios

1 Se um campo de preenchimento obrigatório não estiver completo ao guardar o perfil de um

doente, surge uma mensagem ao lado desse campo. Não poderá guardar esse perfil até ter

digitado algo no campo em questão.

2 Preencha o campo.

3 Clique no botão SAVE  (Guardar).

4 Quando a mensagem de confirmação aparecer, clique em OK.

Editar perfis de doentes

1 Verifique se a área de trabalho do Profile  (Perfil) do doente está aberta.

2 Clique em EDIT (Editar).

3 Edite os dados da secção Patient Profile  (Perfil do doente), conforme necessário.

4 Clique no botão SAVE  (Guardar).

Surge uma mensagem que confirma que o perfil foi guardado.

Eliminar os dados do doente do sistema

1 Verifique se a área de trabalho do Profile  (Perfil) do doente está aberta.
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2 Verifique se este é o doente que pretende eliminar. Ao eliminar o perfil do doente estará

também a eliminar todos os dados do mesmo doente da base de dados do CareLink Pro, não

podendo restaurá-los mais tarde.

3 Clique em >> delete patient record (eliminar registo de doente) acima da secção de

sincronização do perfil.

Surge uma mensagem para o alertar de que todos os dados do doente serão apagados

quando eliminar o registo.

4 Clique em Yes  (Sim) para eliminar o registo do doente.

Efetuar ligação ao CareLink Personal

Se o doente autorizar, pode configurar uma ligação à respetiva conta CareLink Personal. Esta

ferramenta com base na Web permite aos doentes enviar e guardar dados recolhidos pelo

dispositivo e elaborar vários relatórios de terapia.

Depois de ligar à conta CareLink Personal do doente, pode recuperar os dados do dispositivo aí

guardados. É a solução ideal para criar relatórios de terapia no CareLink Pro entre consultas.

Reduz ainda a necessidade de ler o dispositivo do doente no consultório.

Se os doentes ainda não tiverem uma conta CareLink Personal, pode enviar-lhes uma mensagem

de correio eletrónico convidando-os a criar uma conta.

Efetuar uma ligação a uma conta já existente

NOTA: O doente tem de estar presente para executar estas etapas.

1 Assegure-se de que está ligado à Internet.

2 Abra a área de trabalho do Profile  (Perfil) do doente.

3 Verifique se os campos de preenchimento obrigatório na secção Patient Profile  (Perfil do

doente) estão preenchidos.

4 Clique em LINK TO EXISTING ACCOUNT (Efetuar uma ligação a uma conta já existente).

É apresentado o ecrã de Login (Início de sessão) do CareLink Personal.

5 Peça ao doente para:

a. digitar o seu nome de utilizador e palavra-passe;

b. clicar em Sign In (Entrar).

Surge uma página Grant Access (Conceder acesso), com base nas definições de idioma e

região da inscrição do doente.

6 Peça ao doente para:

a. ler os Terms of Use  (Termos de utilização);

b. clicar na caixa de verificação ao lado de I agree to the Terms of Use above... (Concordo

com os termos de utilização acima...);

c. clicar em Grant Access (Conceder acesso);

d. informá-lo quando surgir a página Thank You  (Obrigado).
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7 Se necessário, pode imprimir os Terms of Use (Termos de utilização) para o doente, clicando

no botão Print  (Imprimir). Está agora ligado à conta CareLink Personal deste doente.

Enviar um convite por correio eletrónico

Para enviar uma mensagem de correio eletrónico convidando um doente a criar uma conta no

CareLink Personal, siga estas etapas:

1 Abra a área de trabalho do Profile  (Perfil) do doente.

2 Verifique se os campos de preenchimento obrigatório na secção Patient Profile  (Perfil do

doente) estão preenchidos.

3 Clique em SEND E-MAIL INVITATION TO PATIENT (Enviar convite por correio eletrónico ao

doente).

4 Verifique se os campos Patient Name (Nome do doente), Email Address  (Endereço de

correio eletrónico) e Language (Idioma) estão corretamente preenchidos.

5 Clique em SEND (Enviar).

A área de estado do perfil do doente confirma que a mensagem de correio eletrónico foi

enviada.

Obter dados a partir da ligação a uma conta

Se estiver ligado à conta CareLink Personal de um doente, quaisquer novos dados

provenientes desta conta são automaticamente enviados sempre que abrir o respetivo perfil

de doente no CareLink Pro.

NOTA: Para assegurar que isto acontece, vá até Tools > Options > General (Ferramentas >

Opções > Geral) e verifique se assinalou a caixa ao lado de “Synchronize with CareLink
Personal” (Sincronizar com CareLink Personal).
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Siga estas etapas para obter os dados do CareLink Personal do doente sempre que abrir o

respetivo perfil de doente:

1 Certifique-se que a área de trabalho do Profile  (Perfil) do doente está aberta e que o

computador se encontra ligado à Internet.

2 Selecione Tools > Synchronize Patient Data  (Ferramentas > Sincronizar dados do

doente).

O ícone de sincronização  no separador do doente gira. Quando o ícone para, o processo

está completo.

NOTA: Se o doente já não pretender partilhar os respetivos dados do CareLink Personal,
surge uma mensagem que o informa acerca desta situação.

3 Quaisquer dados adicionais recuperados do CareLink Personal aparecerão nos relatórios do

doente.

Desassociar a conta CareLink Personal de um doente a partir do CareLink Pro

É possível desassociar conta CareLink Personal de um doente a partir do CareLink Pro. Esta

opção apenas está disponível depois de ter sido efetuada uma ligação para um doente.

Impede que o CareLink Pro continue a receber dados da conta CareLink Personal do doente.

Não afeta a utilização pessoal do doente da sua conta CareLink Personal.

1 Abra o registo do doente e aceda à área de trabalho Profile  (Perfil).

2 Clique em UNLINK ACCOUNT  (Desassociar conta).

3 Clique em Yes (Sim) na mensagem de confirmação. O perfil pessoal do doente deixa de estar

ligado ao CareLink Pro.

O estado passa a Not linked (Não ligado) e os botões LINK TO EXISTING ACCOUNT  (Ligar a

uma conta existente) e SEND E-MAIL INVITATION TO PATIENT  (Enviar convite por correio

eletrónico ao doente) são visualizados.
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4

Configuração do hardware

Para ler dados diretamente a partir de um dispositivo, deverá ter o dispositivo do doente e

quaisquer cabos ou dispositivos de comunicação necessários para transferir os dados para o seu

computador.

Em alternativa, se os doentes tiverem enviado os dados do dispositivo para a respetiva conta

CareLink Personal, pode obter os dados ligando-se à sua conta. Para efetuar ligação à conta

CareLink Personal de um doente, consulte Efetuar ligação ao CareLink Personal na página 21.

Ligação de dispositivos

Reveja o diagrama geral para ficar com uma ideia geral de como deve configurar os dispositivos

para que estes comuniquem com o computador. Os diagramas que se seguem ilustram aspetos

específicos da comunicação entre dispositivos.

Para mais pormenores, siga as instruções do CareLink Pro durante a leitura dos dispositivos.
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Descrição geral da configuração do hardware

O exemplo seguinte mostra o CareLink USB a ser utilizado para comunicar entre a bomba de

insulina e o computador. Para uma lista de dispositivos de comunicação suportados, consulte

Dispositivos suportados na página 2.

Exemplos de ligação com cabo série e USB:
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ComLink opcional para utilizar com a bomba de insulina da série Paradigm:

Com-Station opcional para utilizar com a bomba de insulina Medtronic MiniMed 508:
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5

Área de trabalho Devices (Dispositivos)

As informações que serão necessárias para ler o dispositivo de um doente, tais como a marca, o

modelo e o número de série, encontram-se guardadas na área de trabalho Devices (Dispositivos).

Assim, não é necessário indicá-los sempre que efetuar uma leitura de dados no dispositivo.

Os dispositivos presentes na área de trabalho Devices (Dispositivos) encontram-se guardados

numa de duas listas — Active Devices (Dispositivos ativos) ou Inactive Devices (Dispositivos

inativos). Quando adiciona um dispositivo, este é automaticamente colocado na lista Active

Devices (Dispositivos ativos). Apenas pode ler dados de dispositivos incluídos na lista Active

Devices (Dispositivos ativos). Estes são os dispositivos mais provavelmente usados pelo doente

atualmente.

Outros dispositivos que pertençam ao doente mas que não estejam a ser utilizados nesse

momento, podem ser guardados na lista Inactive Devices (Dispositivos inativos). Esta ação

mantém a informação no ficheiro. Estes dispositivos podem ser ativados em qualquer altura.
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Antes de começar

Antes de abrir a área de trabalho Devices (Dispositivos) de um doente, este último tem de ter um

perfil guardado no sistema. Consulte Adicionar novos perfis na página 20.

Para adicionar um dispositivo ou efetuar uma leitura direta de dados, o dispositivo tem de estar

em comunicação com o computador. Consulte Ligação de dispositivos na página 24 para saber

como pode configurar os dispositivos de modo a que estes comuniquem com o computador.

Adicionar um dispositivo

É possível obter dados da conta CareLink Personal do doente relativamente a um dispositivo que

ainda não tenha sido adicionado. Estes dispositivos serão automaticamente adicionados no

momento da sincronização de dados entre o CareLink Personal e o CareLink Pro.

NOTA: Apenas pode existir uma bomba de insulina ativa por doente. Se adicionar uma nova
bomba de insulina, a bomba existente passará para a lista de dispositivos inativos.

Adicionar uma bomba de insulina ou um monitor Guardian da Medtronic

1 Assegure-se de que o dispositivo que está a adicionar foi configurado para comunicar com o

computador (consulte as etapas de ligação em Ligação de dispositivos na página 24).

2 Clique no separador do doente ou faça duplo clique no respetivo nome na tabela Patient

Lookup (Localização de doentes).

3 Clique em Devices (Dispositivos)  para aceder à área de trabalho Devices

(Dispositivos) do doente.

4 Clique em ADD DEVICE (Adicionar dispositivo).

5 Selecione Medtronic Pump/Guardian (bomba de insulina/Guardian da Medtronic). Surge o

Assistente Add Medtronic Pump/Guardian  (Adicionar bomba de insulina/Guardian da

Medtronic).

CareLink Pro Guia do utilizador   Área de trabalho Devices (Dispositivos) 28



NOTA: O modelo da bomba de insulina encontra-se inscrito na parte posterior ou no
ecrã de estado da bomba de insulina.

6 Selecione o botão de opções para especificar o dispositivo que vai adicionar.

Se tiver selecionado a opção MiniMed 508 pump  (bomba de insulina MiniMed 508), passe à

etapa 9.

7 Clique em NEXT (Seguinte). Aparece a página Serial Number  (Número de série).

NOTA: Aparecerá uma mensagem de erro se não introduzir o número de série correto.

Verifique os exemplos desta página e confirme se está a introduzir os caracteres
corretos, inscritos na parte posterior da bomba de insulina. Se necessário, digite de

novo os seis caracteres.

8 Use os exemplos desta página para localizar o número de série com seis caracteres no

dispositivo que vai ser adicionado (se precisar de mais ajuda para o localizar, clique em >>

learn more  [Saber mais]). Digite os seis caracteres no campo Device Serial Number
(Número de série do dispositivo).

9 Clique em NEXT (Seguinte). É visualizada uma página Communication Options  (Opções de

comunicação) semelhante à seguinte.
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10 Clique no menu pendente Choose Port  (Escolher porta) e selecione a porta do seu

computador à qual vai ser ligado o ComLink, o Paradigm Link®, o CareLink USB ou o Com-

-Station. Se não tiver a certeza da porta a escolher, selecione Auto Detect (or USB)  (Deteção

automática [ou USB]).

11 Clique em NEXT (Seguinte). É visualizada a página Test Connection  (Testar ligação)

semelhante à seguinte.

12 Siga todas as instruções do dispositivo e clique em TEST  (Teste).

Surge uma mensagem informando-o que a ligação foi bem sucedida. Se isso acontecer, passe

à etapa seguinte.

NOTA: Este teste não efetua uma leitura dos dados da bomba de insulina, mas verifica

a boa comunicação entre a bomba de insulina e o computador.

Se isso não acontecer, verifique se o hardware de ligação entre o dispositivo e computador

está corretamente ligado. Além disso, pode clicar em BACK  (Retroceder) nas páginas do

Assistente para verificar se os dados do dispositivo que introduziu estão corretos.

13 Clique em DONE  (Pronto).

O dispositivo é adicionado à lista de Active Devices (Dispositivos ativos) do doente.

Adicionar um medidor

1 Clique no separador do doente ou faça duplo clique no respetivo nome na tabela Patient

Lookup (Localização de doentes).

2 Assegure-se de que o medidor que está a adicionar está em comunicação com o computador

(consulte as etapas de ligação em Ligação de dispositivos na página 24).

3 Clique no botão Devices (Dispositivos) para aceder à área de trabalho Devices (Dispositivos)

do doente.

4 Clique no botão ADD DEVICE  (Adicionar dispositivo).
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5 Selecione Blood Glucose Meter  (Medidor de glicose no sangue). Surge o Assistente Add
Blood Glucose Meter  (Adicionar medidor de glicose no sangue).

6 Clique no botão de opções para selecionar a marca correta do medidor.

7 Clique em NEXT (Seguinte). Aparece a página Meter Model  (Modelo do medidor) (esta

página difere dependendo do fabricante do medidor).

8 Clique para selecionar o modelo do medidor que vai adicionar.

9 Clique em NEXT (Seguinte). Aparece a página Communication Options  (Opções de

comunicação).
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NOTA: Apenas as opções válidas para o medidor que está a adicionar ficam disponíveis
para seleção.

10 Clique no menu pendente Choose Port  (Escolher porta) e selecione a porta do seu

computador à qual vai ser ligado o ComLink, o Paradigm Link ou o CareLink USB. Se não tiver

a certeza da porta a escolher, selecione Auto Detect (or USB) (Deteção automática (ou

USB)).

11 Clique em NEXT (Seguinte). Aparece a página Test Connection  (Testar ligação).

12 Siga todas as instruções relativas ao dispositivo e clique em TEST  (Testar).

Se pretender adicionar o medidor CONTOUR® USB da Bayer, assegure-se que o software

GLUCOFACTS® da Bayer está fechado. Verifique o tabuleiro do sistema aqui ilustrado. Se o

ícone GLUCOFACTS estiver visível, clique com o botão direito no ícone e selecione Exit
(sair).

Surge uma mensagem informando-o que a ligação foi bem sucedida. Se isso acontecer, passe

à etapa seguinte.

Se isso não acontecer, verifique se o hardware de ligação entre o dispositivo e computador

está corretamente ligado. Além disso, pode clicar em BACK (Retroceder) no Assistente para

verificar se os dados que introduziu estão corretos.

13 Clique em DONE  (Pronto).

O medidor é adicionado à lista de Active Devices (Dispositivos ativos) do doente.

Ativar ou inativar um dispositivo

Os dispositivos dos doentes podem ser deslocados entre a lista Active Devices (Dispositivos

ativos) e a lista Inactive Devices (Dispositivos inativos), conforme necessário. Um dispositivo tem

de estar ativo para que a leitura dos dados do mesmo seja possível.
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Pode ter todos os medidores que quiser na lista Active Devices (Dispositivos ativos) mas apenas

uma bomba de insulina. Verifique se pretende inativar a bomba que está ativa antes de adicionar

uma nova.

Inativar um dispositivo

1 Clique no separador do doente ou faça duplo clique no respetivo nome na tabela Patient

Lookup (Localização de doentes).

2 Clique no botão Devices (Dispositivos) para aceder à área de trabalho Devices (Dispositivos)

do doente. Os dispositivos podem aparecer na lista com o nome de um dispositivo

equivalente. Consulte Dispositivos suportados na página 2.

3 Clique em >> make this device inactive  (Inativar este dispositivo) sob o dispositivo que

pretende inativar. O dispositivo desloca-se para a lista Inactive Devices (Dispositivos

inativos).

Reativar um dispositivo

1 Clique no separador do doente ou faça duplo clique no respetivo nome na tabela Patient

Lookup (Localização de doentes).

2 Clique no botão Devices  (Dispositivos). Aparece a área de trabalho Devices  (Dispositivos) do

doente.

Os dispositivos podem aparecer na lista com o nome de um dispositivo equivalente. Consulte

Dispositivos suportados na página 2.

3 Clique em >> activate this device (Ativar este dispositivo) sob o dispositivo que pretende

ativar.

O dispositivo desloca-se para a lista Active Devices  (Dispositivos ativos).

Eliminar um dispositivo

Estas etapas eliminarão um dispositivo e respetivos dados da área de trabalho Devices

(Dispositivos) e do sistema CareLink Pro:

1 Clique no separador do doente ou faça duplo clique no respetivo nome na tabela Patient

Lookup (Localização de doentes).

2 Clique no botão Devices (Dispositivos) para aceder à área de trabalho Devices  (Dispositivos)

do doente.

Os dispositivos podem aparecer na lista com o nome de um dispositivo equivalente. Consulte

Dispositivos suportados na página 2.

3 Verifique se o dispositivo se encontra na lista Inactive Devices  (Dispositivos inativos). Se não

estiver, clique em >> Inactivate this device (Inativar este dispositivo) sob a respetiva

referência na lista.

4 Clique em >> delete this device  (Eliminar este dispositivo) sob o dispositivo que pretende

eliminar. Surge uma mensagem para o alertar de que o dispositivo e todos os seus dados

serão apagados do registo do doente.
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5 Clique em YES  (Sim) para eliminar o dispositivo.

O dispositivo e respetivos dados são removidos da área de trabalho Devices (Dispositivos) e

do sistema CareLink Pro. Os dados deste dispositivo deixam de estar disponíveis para

inclusão nos relatórios.

Ler dados do dispositivo

Uma das formas de obter dados do dispositivo é efetuar uma ligação à conta CareLink Personal

do doente (consulte Efetuar ligação ao CareLink Personal na página 21). Outra das formas é efetuar

a leitura diretamente a partir do dispositivo do doente, tal como se descreve aqui.

Os dados do dispositivo do doente podem ser lidos pelo CareLink Pro se o dispositivo estiver

incluído na lista Active Devices (Dispositivos ativos) e estiver em comunicação com o

computador. Tendo obtido estes dados, pode usá-los para elaborar relatórios que o ajudarão a

avaliar a gestão da terapia do doente. Consulte Acerca dos relatórios na página 43  para obter

uma breve descrição dos relatórios disponíveis.

O CareLink Pro pode recolher os seguintes dados de uma bomba de insulina:

• várias configurações da bomba de insulina, como o modo de alerta, o volume do sinal sonoro

e a hora;

• quantidades de insulina basal administradas;

• eventos de bolus e quantidades administradas;

• entradas do Bolus Wizard;

• quantidades de enchimento;

• períodos de suspensão;

• leituras do sensor de glicose ao longo de um período de tempo em bombas de insulina com

capacidades de sensor.
 
O sistema também pode recolher dados de um sistema Guardian REAL-Time, incluindo:

• leituras do sensor de glicose (SG);

• valores de coeficiente do sensor;

• fatores de calibragem do sensor;

• marcadores de refeição;

• injeções de insulina.
 
Adicionalmente, podem ser enviadas várias informações armazenadas num medidor de glicose

no sangue para o sistema durante uma leitura do dispositivo.
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AVISO: Cancele ou termine todos os bolus ativos e índices basais temporários e limpe todos
os alarmes ativos. O funcionamento da bomba de insulina será suspenso durante a leitura.

Completada a leitura, verifique se a bomba de insulina retomou o funcionamento.

ATENÇÃO: Não use o controlo remoto da bomba de insulina durante a leitura da bomba de

insulina. Se a pilha da bomba de insulina estiver fraca, a bomba de insulina não enviará
dados para o PC. Substitua a pilha se o estado indicar que a energia da pilha está fraca.

1 Clique no separador do doente ou faça duplo clique no respetivo nome na tabela Patient

Lookup (Localização de doentes).

2 Assegure-se de que o dispositivo do doente está em comunicação com o computador

(consulte Ligação de dispositivos na página 24).

3 Clique no botão Devices (Dispositivos) para aceder à área de trabalho Devices  (Dispositivos)

do doente.

Os dispositivos podem aparecer na lista com o nome de um dispositivo equivalente. Consulte

Dispositivos suportados na página 2.

4 Localize o dispositivo do qual pretende extrair os dados na lista Active Devices  (Dispositivos

ativos) e verifique se os dados de Choose port (Escolher porta) estão corretos.

No caso das bombas de insulina, clique no menu pendente Amount of Data  (Quantidade de

dados) e selecione a quantidade de dados da bomba que pretende que o CareLink Pro

leia.

5 Clique no respetivo botão READ DEVICE (Ler dispositivo).

6 Siga as instruções específicas do dispositivo e clique em OK.

7 O CareLink Pro apresenta uma barra de progresso que vai sendo atualizada, de modo a

mostrar a porção da leitura do dispositivo que já foi completada.

Se clicar em CANCEL  (Cancelar) durante a leitura do dispositivo, surge uma mensagem que o

alerta para o facto de um cancelamento da ação poder resultar na perda de todos os dados

lidos até ao momento. Será necessário clicar no botão READ DEVICE (Ler dispositivo) para

reiniciar o envio.

- Para cancelar, clique em YES  (Sim).

- Para continuar a ler os dados do dispositivo, clique em NO (Não).

Quando o sistema termina a leitura de dados do dispositivo, verá uma mensagem

confirmando que a leitura do dispositivo está completa.

8 Clique em OK.

- No caso das bombas de insulina, siga as instruções para as retirar do modo de

suspensão.
 
Se o CareLink Pro não conseguir recolher os dados do dispositivo, consulte a secção Resolução de

problemas para obter mais orientações.
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6

Área de trabalho Reports (Relatórios)

O software CareLink Pro disponibiliza vários relatórios que ajudam a uma melhor gestão do

tratamento da diabetes dos doentes. As informações incluídas em cada relatório baseiam-se em

dados obtidos a partir dos dispositivos de um doente e da respetiva conta do software CareLink

Personal.

Os relatórios podem ser criados no ecrã, enviados diretamente para uma impressora ou

guardados em ficheiros de formato TIFF ou PDF que pode anexar a uma Ficha Médica Eletrónica

(Electronic Medical Record ou EMR). É possível criar vários tipos de relatório através de uma só

operação.

Os dados visualizados nestes relatórios são captados a partir dos dispositivos do doente, da

respetiva conta CareLink Personal ou de ambas as formas.

NOTA: O guia de consulta dos relatórios inclui mais pormenores sobre os componentes dos

relatórios, além de exemplos de relatórios. Pode aceder ao guia de consulta dos relatórios
através do software CareLink Pro, indo até Help > View Report Reference Guide (PDF)

(Ajuda > Ver Guia de Consulta dos Relatórios (PDF)) e selecionando o idioma apropriado.

CareLink Pro Guia do utilizador   Área de trabalho Reports (Relatórios) 36



Antes de começar

Se quiser criar um relatório que abranja um determinado período de tempo, terá de ter os dados

do dispositivo do doente referentes a esse período. Pode ainda ser necessário que o dispositivo

do doente esteja ligado ao computador para obter os dados atualizados, antes de elaborar os

relatórios.

Estude atentamente a etapa Verify Report Settings  (Verificar as configurações do relatório) antes

de elaborar um relatório. Nesta etapa poderá configurar de forma mais precisa um relatório, de

modo a captar os dados do doente que pretende.

Criação de relatórios

As secções seguintes ajudam a compreender melhor os relatórios disponíveis, bem como o

processo utilizado para a sua criação.

Se estiver familiarizado com o processo de elaboração de relatórios e souber quais os relatórios

que pretende efetuar, pode começar a criar relatórios.

Abrir a área de trabalho Reports (Relatórios)

Clique no separador do doente ou clique no botão Open Patient (Abrir doente)  e faça duplo

clique sobre o nome do doente.

É apresentada a área de trabalho Reports (Relatórios).

NOTA: Para assegurar que tem os dados mais recentes do dispositivo do doente recolhidos

a partir da conta CareLink Personal do doente, clique em SYNC DATA (Sincronizar dados).

Seleção do período do relatório

1 Para alterar o período de tempo refletido no(s) relatório(s), clique no menu pendente

Duration  (Duração) e selecione a duração do período de tempo (a duração máxima é de 12

semanas).

2 As datas de início e fim do período são automaticamente definidas, a não ser que escolha a

opção custom date range (intervalo de datas personalizado).

NOTA: Se selecionar um intervalo de datas mais extenso que o permitido, verá uma
mensagem de erro. Ajuste a duração ou as datas.

Se pretender definir um intervalo de datas personalizado, clique nos menus pendentes From
(De) ou Through (Até) e selecione o mês, data ou ano pretendidos.

Data calendar (Calendário de dados)

A área de calendário de dados da área de trabalho Reports (Relatórios) mostra uma janela de três

meses de dados para os relatórios.

CareLink Pro Guia do utilizador   Área de trabalho Reports (Relatórios) 37



As barras azuis representam dados do dispositivo. A barra cor de laranja representa o período de

elaboração de relatórios que selecionou. Uma sobreposição dos dados do dispositivo e do

período do relatório significa que dispõe de dados para alguns ou para todos os períodos do

relatório visualizados.

A área do calendário de dados mostra inicialmente os três últimos meses. Para ver outros meses,

clique nos botões com setas  em cada extremidade dos meses.

Selecionar dados de cada fonte a incluir

1 Se o doente utilizar um medidor de GS que seja possível ligar à sua bomba de insulina, clique

para escolher uma das opções seguintes para elaborar um relatório dos dados de GS deste

medidor:

- In the pump (na bomba de insulina):  As vantagens desta seleção relacionam-se com o

facto de apenas ter de efetuar a leitura de dados a partir da bomba de insulina do

doente, de as leituras de GS virem acompanhadas da respetiva hora atribuída pela

bomba de insulina e de as leituras estarem diretamente ligadas a quaisquer cálculos do

Bolus Wizard utilizados. Uma desvantagem é que caso ocorram dificuldades de

comunicação entre a bomba de insulina e o medidor associado, das leituras de GS deste

período problemático não serão incluídas no relatório. Além disso, para as bombas de

insulina MiniMed Paradigm anteriores à 522/722, todas as leituras de GS relacionadas

com os cálculos do Bolus Wizard que não sejam objeto de reação, não são incluídas no

relatório.

- In the link meter(s) (No[s] medidor[es] ligado[s]):  a vantagem desta seleção é o facto de

todas as leituras guardadas no medidor ligado serem incluídas no relatório. A

desvantagem relaciona-se com o facto de ser obrigatória a sincronização prévia dos

relógios da bomba de insulina e do medidor para que seja possível correlacionar os

dados do medidor e os dados da bomba de insulina. Tem ainda de efetuar a leitura

separada dos dados da bomba e do medidor associado.

2 Para adicionar os dados do dispositivo aos relatórios, selecione a caixa de verificação ao lado

do dispositivo em questão.

Não pode adicionar dispositivos que tenham sido excluídos devido à sua seleção na etapa 1.

Para alterar esta situação, selecione a outra opção do medidor associado.

3 Para excluir os dados do dispositivo dos relatórios, anule a seleção da caixa de verificação ao

lado do dispositivo em questão.
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Não pode anular a seleção das caixas de verificação relacionadas com a opção selecionada na

etapa 1. Para alterar esta situação, selecione a outra opção do medidor associado.

Verificar os dados do dispositivo

1 Observe a área do calendário na área de trabalho Reports (Relatórios) para ver se a barra cor

de laranja, que representa o período abrangido pelo relatório, se sobrepõe às barras azuis

que representam os dados do dispositivo.

2 Se as barras se sobrepuserem durante todo o período abrangido pelo relatório, tem dados

para criar o(s) relatório(s). Pode clicar em NEXT (Seguinte) e passar à Verificação das

configurações dos relatórios na página 40.

3 Se as barras não se sobrepuserem ou se não se sobrepuserem o suficiente, tem algumas

opções:

- Ajustar o período abrangido pelo relatório.

- Obter dados adicionais do dispositivo.

Obter dados adicionais do dispositivo

1 Para obter mais dados de um dispositivo, clique no botão READ DEVICE  (Ler dispositivo)

associado ao dispositivo.

Surge a barra Read Device (Ler dispositivo).

AVISO: Cancele ou termine todos os bolus ativos e índices basais temporários e limpe

todos os alarmes ativos. O funcionamento da bomba de insulina será suspenso durante
a leitura. Completada a leitura, verifique se a bomba de insulina retomou o
funcionamento.

ATENÇÃO: Não use o controlo remoto da bomba de insulina durante a leitura da
bomba de insulina. Se a pilha da bomba de insulina estiver fraca, a bomba de insulina
não enviará dados para o PC. Substitua a pilha se o ecrã de estado do dispositivo

indicar que a energia da pilha está fraca.

2 Verifique se os dados do campo Choose port (Escolher porta) são os corretos para este

dispositivo.

Para alterar esta configuração, clique no menu pendente do campo e selecione uma

configuração diferente.

3 Assegure-se de que o dispositivo está ligado ao computador.
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4 Se o dispositivo for uma bomba de insulina, pode especificar a quantidade de dados que

pretende obter do mesmo. Clique no menu pendente Amount of Data  (Quantidade de

dados) e selecione uma quantidade.

NOTA: Se selecionar All available data  (Todos os dados disponíveis), o sistema lê todos
os dados na bomba de insulina. Esta ação sobrepõe a gravação a todos os dados

duplicados presentes no sistema.

5 Clique em READ DEVICE  (Ler dispositivo). Leia atentamente a mensagem que surge no ecrã,

uma vez que fornece instruções específicas para a leitura da bomba de insulina.

6 Siga as instruções e clique em OK.

Surge a barra de progresso Read Device (Ler dispositivo).

Pode optar por cancelar a leitura em qualquer altura, clicando em CANCEL  (Cancelar).

Surge uma mensagem, confirmando que a leitura está completa.

7 Clique em OK.

Os dados do dispositivo são agora visíveis no calendário de dados.

8 Clique em NEXT (Seguinte) no topo da área de trabalho Reports  (Relatórios).

É visualizada a etapa Verify Reports Settings (Verificar configurações do relatório). Esta etapa

permite assegurar que as configurações deste doente estão corretas antes de elaborar o(s)

relatório(s).

Verificação das configurações dos relatórios

1 Assegure-se de que as configurações de Glucose Target (Objetivo de glicose) estão nos

valores pretendidos. Digite estes valores ou clique nas setas ascendente ou descendente nos

campos Low  (Inferior) e High  (Superior) para aumentar ou baixar os valores.

NOTA: São apresentados marcadores de leitura do medidor (|| |) na linha temporal de
despertar e deitar, bem como na linha temporal dos marcadores de refeição. Na
medida em que alguns relatórios se baseiam em dados encontrados em tempos de

refeição definidos, ou de horas de despertar ou deitar, é importante que os marcadores
de eventos do Bolus Wizard e de leitura do medidor sejam agrupados de forma correta.

2 Para adicionar um novo período de refeição, clique em ADD MEAL  (Adicionar refeição). Para

editar um período de refeição existente, clique em qualquer ponto de um período de

refeição disposto na linha de tempo.

O editor Meal Period (Períodos de refeição), localizado por baixo da linha de tempo, fica

ativo.

NOTA: Pode ter cinco períodos de refeição, no máximo. Os períodos predefinidos são

pequeno-almoço, almoço e jantar.

3 Digite texto ou clique nas setas para selecionar as configurações pretendidas.
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Se apenas quiser usar estas configurações para esta refeição, limpe a caixa de verificação Use
these parameters for all of this patient's meals (Usar estes parâmetros para todas as

refeições deste doente).

- Meal Name (Nome da refeição):  nome que pretende atribuir ao período de refeição.

- Meal Time Period (Período de tempo da refeição): horas entre as quais decorre a

refeição.

- Pre-Meal BG Target (mg/dL or mmol/L) (Objetivo de GS antes da refeição [mg/dl ou
mmol/l]): limites inferior e superior dos objetivos de glicose do doente antes da

refeição.

- Pre-Meal Analysis Period (Período de análise antes da refeição):  período de tempo

em que a glicose será analisada antes do início de uma refeição. As leituras de glicose

captadas durante este período são usadas na análise dos relatórios exaustivos.

- Post-Meal BG Target (mg/dL or mmol/L) (Objetivo de GS após a refeição [mg/dl ou
mmol/l]): limites inferior e superior dos objetivos de glicose do doente após a

refeição.

- Post-Meal Analysis Period (Período de análise após a refeição):  período de tempo em

que a glicose será analisada após uma refeição. As leituras de glicose captadas durante

este período são usadas na análise dos relatórios exaustivos.

É possível alterar a duração de um período de refeição estabelecido ou de um período

“ao acordar” e “ao deitar”, clicando nos ponteiros de início ou de fim e arrastando e

largando os ponteiros ao longo da linha de tempo.

NOTA: Os períodos das refeições não podem sobrepor-se, embora as linhas de início e

de fim possam tocar-se. Os períodos das refeições têm de ter uma duração mínima de
60 minutos.

4 Para utilizar a configuração desta refeição em todas as outras refeições do doente, verifique

se a caixa de verificação ao lado de Use these parameters for all of this patient’s meals
(Utilizar estes parâmetros em todas as refeições deste doente) se encontra selecionada.

5 Depois de ter criado ou editado um período de refeição, clique em SAVE  (Guardar).

6 Para remover um período de refeição, clique em DELETE MEAL (Eliminar refeição). Clique em

DELETE (Eliminar) quando lhe for pedido para confirmar.

7 O CareLink Pro memorizará estas configurações para a próxima vez que elaborar um relatório

para o mesmo doente. Para as guardar associadas a este doente, clique em SAVE SETTINGS
(Guardar configurações).

8 Clique em NEXT (Seguinte) no topo da área de trabalho Reports  (Relatórios).
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Esta é a etapa de seleção e elaboração de relatórios do processo. Fornece uma lista de tipos

de relatórios, além de uma Tabela de Dados que o ajuda a incluir ou excluir os dados de

determinados dias do(s) relatório(s) Daily Detail (Diário exaustivo).

NOTA: Para alterar a visualização de Data Table (Tabela de dados), clique em
>>customize columns (Personalizar colunas). Consulte Preferências de Report Generation

(Criação de relatórios) na página 16.

9 Para imprimir o ecrã, clique no ícone PRINT (Imprimir) .

Seleção de tipos de relatórios e datas de inclusão

1 Selecione a caixa de verificação ao lado do(s) relatório(s) que pretende incluir no conjunto de

relatórios.

NOTA: A caixa de verificaça ̃o do relatório do Dashboard/Episode Summary (Painel/

Resumo do episódio) não estará disponível se se verificarem menos de cinco dias de
dados do sensor e da bomba de insulina no período de tempo selecionado ou se os
dados do período de tempo forem de um monitor Guardian.

2 Se tiverem sido lidos dados de uma bomba de insulina ou monitor Guardian mais que uma

vez durante este período abrangido pelo relatório, é possível que existam várias perspetivas

do dispositivo:

a. Verifique se a caixa de verificação ao lado de Device Settings Snapshot  (Perspetiva das

configurações do dispositivo) se encontra selecionada.

b. Clique na seta pendente e selecione uma data e hora para a perspetiva.

- Bomba de insulina:  Selecione uma perspetiva da bomba de insulina do doente.

- Guardian:  Selecione uma perspetiva do monitor Guardian do doente.

Se um dos campos se apresentar esbatido, não existem perspetivas disponíveis durante o

período do relatório.

3 Percorra a Data Table (Tabela de dados) para rever as informações disponíveis para o

relatório Daily Detail (Diário exaustivo).
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- Pode ordenar os dados de cada coluna. Clique no cabeçalho da coluna para ordenar os

dados em ordem ascendente. Clique no cabeçalho de novo para ordenar os dados em

ordem descendente.

NOTA: Se não existirem dados para uma determinada data, esta última não poderá ser
selecionada.

4 Selecione a caixa de verificação nas linhas da tabela de dados para qualquer data que

pretenda ver refletida num relatório Daily Detail (Diário exaustivo).

- Para incluir ou excluir todas as datas do relatório Daily Detail (Diário exaustivo) com um

clique, selecione a caixa de verificação no topo da coluna das caixas de verificação da

Data Table (Tabela de dados).

Elaboração de relatórios

1 Depois de verificar as seleções de relatórios, clique em GENERATE REPORTS (Criar relatórios)

no topo da área de trabalho Reports  (Relatórios).

Surge uma lista de opções.

2 Selecione uma opção para pré-visualizar, imprimir ou guardar o(s) relatório(s).

Se tiver selecionado Preview  (Pré-visualizar), surge a janela Preview  (Pré-visualizar).

3 Clique nos botões com setas para navegar nos relatórios com várias páginas.

4 Clique num dos outros botões no tipo da janela Preview (Pré-visualizar) para guardar ou

imprimir o(s) relatório(s).

5 Para fechar esta janela, clique no botão Close  (Fechar)  no canto superior direito da

janela.

Acerca dos relatórios

Este tópico contém uma descrição de cada relatório. O guia de consulta dos relatórios inclui mais

pormenores sobre os componentes dos relatórios, além de exemplos de relatórios. Pode aceder

ao guia de consulta dos relatórios através do software CareLink Pro:

1 Help > View Report Reference Guide (PDF) (Ajuda > Ver Guia de Consulta dos Relatórios

[PDF]).

2 Selecione um idioma para o guia de consulta dos relatórios.
 
Os relatórios do CareLink Pro têm em comum os seguintes elementos:

• Cabeçalho do relatório  — O cabeçalho do relatório inclui dados identificativos, como o

nome do relatório, o nome do doente e a origem dos dados.

• Hidratos de carbono e níveis de glicose no sangue  — Nos gráficos e tabelas, as unidades

de hidratos de carbono são apresentadas em itálico e os níveis de glicose no sangue são

visualizados a negrito.
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• Dados de fim de semana  — Os dias do fim de semana apresentam-se a negrito para que

possa identificá-los facilmente.

• Legendas — Aparece uma legenda dos símbolos ao fundo de cada relatório. Embora um

símbolo possa ser usado em vários relatórios, as legendas são específicas de cada

relatório.

Dashboard and Episode Summary (Painel e Resumo do episódio)

O Dashboard and Episode Summary (Painel e Resumo do Episódio) é um relatório de duas

páginas que tem como objetivo disponibilizar um resumo do controlo glicémico geral de um

doente num período de tempo selecionado. A primeira página do relatório chama-se Therapy

Management Dashboard (Painel de Gestão de Terapia) e a segunda página chama-se Resumo do

Episódio. Abaixo é-lhe disponibilizada uma descrição de cada página.

Therapy Management Dashboard (Painel de gestão de terapia)

O Therapy Management Dashboard (Painel de gestão de terapia) permite-lhe visualizar o nível

geral de controlo glicémico em cada momento do dia. A página do Dashboard (Painel) ilustra as

linhas de sobreposição de glicose do sensor e a informação de administração de insulina num

gráfico diário. O Dashboard (Painel) também mostra o período noturno e períodos perto das

horas das refeições para ajudá-lo a avaliar o controlo glicémico antes e após as refeições. Usando

estas ilustrações poderá diferenciar visualmente padrões clínicos chave, tais como a

hiperglicemia, hipoglicemia e variabilidade na perspetiva gráfica geral do controlo glicémico. O

Dashboard (Painel) inclui uma análise estatística de padrões hipoglicémicos e hiperglicémicos

recorrentes em determinados momentos do dia.

Além disso, o Dashboard (Painel) oferece a possibilidade de correlacionar o controlo glicémico

por momento do dia com modificadores de terapia chave, tais como o padrão basal, a absorção

de insulina, a sensibilidade à insulina e a taxa de hidratos de carbono. Isto diminui a necessidade

de correlacionar acontecimentos de vários relatórios de forma manual. Por fim, o Dashboard

(Painel) mostra estatísticas gerais de utilização da bomba de insulina e sensor.

Episode Summary (Resumo de Episódio)

A página do Episode Summary (Resumo de Episódio) faculta detalhes sobre episódios de

hipoglicemia e hiperglicemia. Destaca os episódios mais críticos e a frequência de

acontecimentos correlacionados que importa investigar detidamente. Se aplicável, o relatório

enumera as causas comummente conhecidas para os casos de hipoglicemia e hiperglicemia e

oferece considerações terapêuticas.

Por fim, o Episode Summary (Resumo de Episódio) faculta observações gerais sobre medidas de

conformidade ou comportamentais chave relacionadas com a bomba de insulina, CGM e

utilização do medidor de GS. Estas observações podem não estar relacionadas com o episódio.

Adherence Report (Relatório de adesão)

O Adherence Report (Relatório de adesão) apresenta dados que descrevem como as bombas de

insulina e os sensores são usados e ainda os comportamentos do doente relevantes para a

terapia. Responde à pergunta, “Existem dados suficientes para facultar uma imagem rigorosa da
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forma como o doente utiliza a sua bomba de insulina e sensor, se for o caso?”. Responde ainda à

pergunta, “Os doentes seguem a terapia conforme as instruções recebidas?” Indicam ainda se terá

de falar com os seus doentes sobre a forma como estão a gerir a sua diabetes.

Sensor and Meter Overview Report (Relatório perspetiva geral do sensor e
medidor)

O Sensor and Meter Overview Report (Relatório perspetiva geral do sensor e medidor) fornece

uma representação gráfica das médias e dos níveis diários de glicose recolhidos com sensor e

medidor, decompostos por hora ao longo de 24 horas e relacionados com as refeições e padrões

de sono. São ainda incluídas as estatísticas de utilização de insulina e das leituras de glicose do

doente.

É elaborada uma análise semelhante dos dados do sensor na primeira página deste relatório, se

existirem dados de sensor disponíveis. Quando não existirem dados disponíveis sobre o sensor, a

página de análise de dados do medidor aparecerá como a primeira página.

A(s) página(s) final/finais do relatório mostra(m) o nível e qualidade diária do controlo glicémico,

de hidratos de carbono e insulina do doente. Cada página mostra como esse controlo varia

durante cada dia, ao longo de todo o período abrangido pelo relatório até um máximo de 14 dias

por página.

Relatório Logbook (Livro de registo) 

O relatório Logbook (Livro de registo) inclui dados relativos à insulina, hidratos de carbono e

glicose do medidor para cada dia do período abrangido pelo relatório. Fornece um diário de

eventos registados por hora, além de totais e médias diárias. Cada página contém até 14 dias. Se

o período abrangido pelo relatório ultrapassar 14 dias, são criadas páginas adicionais.

Device Settings Snapshot (Perspetiva das configurações do dispositivo)

O Device Settings Snapshot Report (Relatório perspetiva das configurações do dispositivo)

apresenta uma perspetiva das configurações da bomba de insulina ou monitor Guardian REAL-

-Time do doente em relação a uma data e hora específicas. Isto pode ajudar a interpretar outros

relatórios ou pode simplesmente documentar as configurações do doente.

As configurações da bomba de insulina ou monitor são registadas apenas quando é efetuada a

leitura do dispositivo. Se não for efetuada uma leitura do dispositivo durante o período abrangido

pelo relatório, não ficarão disponíveis quaisquer configurações.

Daily Detail Report (Relatório diário exaustivo)

O Daily Detail Report (Relatório diário exaustivo) apresenta os dados de glicose, quantidades de

hidratos de carbono e a utilização da insulina pelo doente para o dia selecionado. É elaborado um

relatório separado para cada dia selecionado na Data Table (Tabela de dados).

O Daily Detail Report (Relatório diário exaustivo) contém uma perspetiva detalhada de cada dia

selecionado. Permite-lhe concentrar-se num dia em particular, se achar que ocorreu algo de

interesse para a terapia do doente.
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Exportar dados

É possível exportar dados do dispositivo captados e guardados pelo CareLink Pro. Assim, dispõe

de todos os dados do dispositivo de um doente para utilizar como estatísticas ou na criação de

tabelas ou relatórios especializados. O ficheiro .csv pode ser importado para o Microsoft Excel ou

determinados programas de estatísticas clínicas onde os respetivos dados podem ser tratados.

O ficheiro .csv contém dados que registam as ações do dispositivo. Por exemplo, enumera o

registo das leituras do medidor de glicose, a recepção do valor da leitura do medidor pela bomba

de insulina ou a alteração do índice basal.

NOTA: Esta é uma função avançada e exige que se familiarize com os dados não tratados
do dispositivo. É ainda necessário que tenha bastante experiência na utilização do software
para o qual vai importar o ficheiro .csv.

Siga estas etapas para utilizar a função de exportação do CareLink Pro:

1 Clique no separador do doente ou clique no botão Open Patient (Abrir doente)  e faça

duplo clique sobre o nome do doente.

2 Assegure-se de que a área de trabalho Reports  (Relatórios) está aberta.

3 Use os campos Duration  (Duração) ou From/Through  (De/Até) para definir as datas e a

duração do relatório.

A duração máxima que é possível selecionar é de 12 semanas.

4 Clique na hiperligação export selected data (exportar dados selecionados).

Surge a caixa de diálogo Export Data to CSV File (Exportar dados para ficheiro CSV).

5 Navegue até à localização do seu computador em que pretende guardar o ficheiro .csv. Se

pretender mudar o nome do ficheiro, digite-o na caixa File name  (Nome do ficheiro).

6 Clique no botão SAVE  (Guardar).

NOTA: Para mais informações sobre os dados visualizados nos ficheiros CSV, consulte o

apêndice de dados CSV.

O ficheiro .csv fica guardado no computador, no local selecionado. Pode agora importá-lo

para qualquer programa que suporte este tipo de ficheiro.
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7

Administração do sistema

É importante efetuar com regularidade cópias de segurança da base de dados do CareLink Pro. A

base de dados guarda todos os dados do sistema que tenham vindo a acumular-se nos registos

do doente, incluindo os dados do perfil,  os dados recolhidos no dispositivo e as configurações

dos relatórios.

É também importante que disponha da versão mais recente do CareLink Pro. As versões

atualizadas são disponibilizadas periodicamente e podem conter melhorias importantes. Pode

optar por procurar atualizações ou ser avisado quando disponíveis.

Aplicar atualizações de software

Estarão disponíveis atualizações ocasionais do software CareLink Pro. Quando surgir um aviso

de uma atualização, proceda da seguinte forma para transferir a última versão do software.

NOTA: Efetue uma cópia de segurança da base de dados antes de instalar uma atualização
do software. Consulte Efetuar cópias de segurança da base de dados na página 48.

1 Verifique se dispõe de uma ligação ativa à Internet no computador.

2 A mensagem CareLink Pro Update (Atualização do CareLink Pro) surge quando existe uma

atualização ao CareLink Pro. Esta mensagem permite-lhe optar por transferir a atualização.

3 Clique em DOWNLOAD (Transferir) (se clicar em CANCEL [Cancelar], a notificação de

atualização será encerrada). Poderá transferir a atualização mais tarde).

Surge uma mensagem de aviso que recomenda a realização de uma cópia de segurança da

base de dados.

4 Clique em YES  (Sim) para criar uma cópia de segurança da base de dados (consulte Efetuar

cópias de segurança da base de dados na página 48  para obter mais informações sobre este

procedimento). Clique NO (Não) se já tiver criado uma cópia de segurança dos dados.

Surge uma mensagem, confirmando que a nova versão do CareLink Pro foi transferida.
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5 Para começar a utilizar a versão mais recente do CareLink Pro, clique em YES  (Sim) para

encerrar e abrir de novo a aplicação de software. Clique em NO (Não) se preferir aguardar

para reiniciar o CareLink Pro.

Desativar as atualizações automáticas

Se não pretender receber notificações automáticas das atualizações do CareLink Pro, siga estas

etapas:

1 Selecione Tools > Options  (Ferramentas > Opções).

2 Clique no separador General  (Geral).

3 Na secção Communications (Comunicações), limpe a caixa de verificação ao lado de

Automatically check for software updates  (Verificar automaticamente as atualizações de

software).

Verificação manual de atualizações

Pode verificar manualmente se existem atualizações do CareLink Pro, em qualquer altura.

NOTA: Efetue uma cópia de segurança da base de dados antes de instalar uma atualização

do software. Consulte Efetuar cópias de segurança da base de dados na página 48.

1 Verifique se dispõe de uma ligação ativa à Internet no computador.

2 Selecione Tools > Check for Software Updates (Ferramentas > Verificar atualizações do

software).

3 Receberá uma mensagem se não existirem atualizações disponíveis no momento. Se existir

uma atualização, surge uma mensagem de CareLink Pro Update (Atualização do CareLink

Pro).

4 Siga o procedimento descrito em Aplicar atualizações de software na página 47.

Criar cópias de backup e restabelecer a base de dados

É aconselhável estabelecer um plano regular para a realização de cópias de segurança. Tal

garantirá a regularidade da realização de cópias de segurança e reduzirá o risco de perda de

dados.

Se estiver a efetuar uma cópia de segurança da base de dados ou a restaurá-la, o sistema

apresenta uma mensagem de alerta caso existam utilizadores ativos do software noutros

computadores.

Efetuar cópias de segurança da base de dados

As seguintes etapas permitem-lhe efetuar cópias de segurança da atual base de dados, em

local a selecionar.

1 Certifique-se que todos os registos dos doentes estão fechados.

CareLink Pro Guia do utilizador   Administração do sistema 48



2 Selecione Tools > Backup Database (Ferramentas > Efetuar cópia de segurança da base de

dados).

NOTA: As cópias de segurança da base de dados podem ser guardadas numa unidade
de rede ou num suporte amovível de armazenamento de dados (como um DVD, CD ou
unidade USB).

3 Navegue até à localização do seu computador onde pretende guardar o ficheiro de cópia de

segurança. Se pretender mudar o nome do ficheiro de segurança, digite-o na caixa File name

(Nome do ficheiro).

4 Clique no botão Save (Guardar). É visualizada uma barra de progresso enquanto a base de

dados é guardada.

Surge uma mensagem quando a cópia de segurança estiver completa.

5 Clique em OK para fechar a mensagem.

Restaurar a base de dados

A atual base de dados pode ter de ser substituída se depois não for possível aceder à mesma

ou usá-la. Quanto mais atual for a cópia de segurança, menos dados se perderão se substituir

a base de dados.

ATENÇÃO: Ao restaurar a base de dados a partir de uma cópia de segurança, perde todos
os novos dados criados na base de dados atual, desde a data em que efetuou a cópia de
segurança selecionada.

As seguintes etapas permitem-lhe selecionar uma cópia de segurança para substituir a atual

base de dados.

1 Certifique-se que todos os registos dos doentes estão fechados.

2 Selecione Tools > Restore Database  (Ferramentas > Restaurar base de dados).

3 Selecione o ficheiro da cópia de segurança que pretende usar para substituir a atual base de

dados (habitualmente, o mais recente).

4 Clique em Open (Abrir). Surge uma mensagem de aviso relativa aos dados que podem ser

perdidos se continuar com a operação de restauro.

5 Para continuar, clique em OK. É visualizada uma barra de progresso enquanto a base de

dados está a ser restaurada.

Surge uma mensagem quando a base de dados estiver restaurada.

6 Clique em OK para fechar a mensagem.

Quando o sistema está indisponível

Se tentar inicializar o sistema enquanto outro utilizador estiver a criar uma cópia de segurança ou

um restauro, receberá uma mensagem a notificar-lhe que o sistema não está disponível. Não

conseguirá aceder ao sistema até a tarefa estar concluída.

Efetue uma das seguintes ações:
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• Aguarde que o processo termine e que o sistema fique disponível.

• Clique em CANCEL (Cancelar) para sair e tentar de novo mais tarde.
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8

Resolução de problemas

Este tópico foi concebido para o ajudar a resolver problemas que possam ocorrer durante a

utilização do software CareLink Pro. Também contém instruções para desinstalar o software

CareLink Pro, se necessário.

Erros gerais na utilização da aplicação

Se tentar transferir uma atualização de software da Internet, pode receber uma mensagem

indicando que não tem a necessária autorização para o fazer. É preciso ter o estatuto de

administrador do sistema para transferir as atualizações do software CareLink Pro.

1 Encerre a aplicação de software CareLink Pro e reinicie o seu computador.

2 Peça a uma pessoa com estatuto de administrador para iniciar uma sessão no

computador.

3 Siga as instruções de Aplicar atualizações de software na página 47.

Not connected to the database (Não está ligado à base de dados)

Uma mensagem de erro informando que não se encontra ligado à base de dados indica um dos

seguintes problemas:

• A base de dados foi deslocada. A base de dados tem de estar no mesmo local que foi

selecionado durante a instalação do software CareLink Pro. Se tiver sido deslocada, tem de

ser novamente colocada no local selecionado durante a instalação.

• Não está ligado à unidade de rede onde está localizada a base de dados. Se a base de dados

estiver localizada numa unidade de rede, é possível que ocorram ocasionalmente problemas

na rede que impeçam o acesso à unidade. Contacte o seu departamento de informática para

que o ajudem a restabelecer a ligação à unidade de rede onde está localizada a base de

dados.
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Esqueceu-se da palavra-passe da sua instituição de saúde para aceder ao
CareLink Pro

Se ninguém se lembrar da palavra-passe da sua instituição de saúde para iniciar uma sessão no

CareLink Pro, será necessário reinstalar o software CareLink Pro e criar uma nova base de dados.

Uma vez reinstalado o software, não conseguirá aceder a quaisquer informações de doentes que

se encontravam na base de dados anterior. Guarde a palavra-passe criada durante a nova

instalação num local do escritório para que não perca dados futuros.

Erros na leitura de dispositivos

Erro Explicação

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is available, or select another port.
(Não foi possível abrir a porta série selecionada. Pode
estar em curso outra operação nessa porta. É favor
aguardar até a porta ficar disponível ou selecionar
outra porta.)

Verifique se a porta de comunicação selecionada não
está a ser usada por outro programa ou selecione
outra porta. Experimente reiniciar o computador que
está a utilizar e tentar novamente efetuar a leitura do
dispositivo. O hardware (como o cabo) de ligação à
porta ou a própria porta podem estar danificados.
Ligue o hardware a outra porta e tente novamente
efetuar a leitura do dispositivo para ajudar a
determinar o problema.

Auto Detect could not find the device on any
available port. Please check the cable connection,
device battery & status and try again, or try specifying
a serial port. (A deteção automática não conseguiu
localizar o dispositivo em nenhuma porta disponível.
Deve verificar a ligação do cabo, a pilha e o estado do
dispositivo e tentar de novo ou tentar especificar uma
porta série.)

Verifique a ligação entre o cabo e o PC e verifique o
bom estado da bateria do dispositivo. Em caso
afirmativo, experimente especificar a porta série do PC
à qual o cabo está ligado, em vez de selecionar a
deteção automática.

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device. (Dispositivo não encontrado na
porta série selecionada. Deve verificar a ligação por
cabo, a pilha e o estado do dispositivo e tentar de
novo ou tentar efetuar a deteção automática do
dispositivo.)

Verifique a ligação entre o cabo e o PC e verifique o
bom estado da bateria do dispositivo. Em caso
afirmativo, experimente selecionar um número de
porta série diferente no PC ou escolher a opção de
deteção automática.

Unable to communicate with the device. Please ensure
you’ve attached and selected the correct device, check
the cable connection, device battery and status, and
try again. (Não foi possível comunicar com o
dispositivo. É favor verificar se fixou e selecionou o
dispositivo correto, verificar a ligação por cabo, o
estado e a pilha do dispositivo e tentar de novo.)

Verifique todas as configurações selecionadas para a
leitura do dispositivo, incluindo o nome do dispositivo,
número de série e tipo de ligação. Verifique ainda se
o dispositivo, o cabo e o PC estão devidamente
ligados. Verifique se a pilha e o estado do alarme do
dispositivo se encontram em boas condições. Tente
novamente efetuar a leitura.

Unexpected response... retrying (n%) (Resposta
inesperada... a tentar de novo [n%])

Foi lido um valor inesperado no dispositivo. O sistema
tenta uma nova comunicação até o utilizador cancelar
esta ação ou até a comunicação ser efetuada com
êxito.

The link device was found, but the device (<serial #>)
is not responding. Please verify the device’s serial
number, place the device closer to the link device to
minimize signal interference, check device battery and
status. (O dispositivo de ligação foi localizado mas o
dispositivo [n.º de série] não está a responder. Deve
verificar o número de série do dispositivo, aproximar o
dispositivo ao dispositivo de ligação para minimizar a
interferência de sinal, verificar a pilha e o estado do
dispositivo.)

Verifique se foi introduzido o número de série correto.
Se não tiver sido introduzido o número correto,
reintroduza o número de série correto. Se o número
de série estiver correto, tente aproximar o dispositivo
de ligação do dispositivo de comunicação. Afaste o
dispositivo de ligação e o dispositivo de comunicação
de possíveis fontes de interferência (tais como outros
dispositivos de RF). Verifique a potência da pilha do
dispositivo e, se estiver a transferir dados de uma
bomba de insulina, verifique o estado de
administração da bomba de insulina.
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Erro Explicação

This pump is delivering a temp basal. Please cancel
the temp basal or wait until it completes, and then try
again. (Esta bomba de insulina está a administrar um
índice basal temporário. É favor cancelar o índice
basal temporário ou aguardar até que o mesmo se
complete e tentar de novo.)

A bomba de insulina da qual está a tentar efetuar a
leitura está a administrar um índice basal temporário.
Aguarde até ao final da administração do índice basal
temporário para efetuar a leitura da bomba de
insulina ou cancele o índice basal temporário e, de
seguida, efetue a leitura.

This device has active errors or alarms. Please clear
the alarms and try again. (Esta bomba de insulina tem
erros ou alarmes ativos. É favor eliminar os alarmes e
tentar de novo.)

Existem alarmes ativos na bomba de insulina que
impedem a leitura. Leia as instruções sobre alarmes
para apagar o alarme. Apague o alarme e tente
efetuar novamente a leitura da bomba de insulina.

This pump is delivering a bolus. Please cancel the
bolus or wait until it completes, and then try again.
(Esta bomba de insulina está a administrar um bolus.
É favor cancelar o bolus ou aguardar até que o
mesmo se complete e tentar de novo.)

A bomba de insulina na qual está a tentar efetuar a
leitura está a administrar um bolus. Aguarde o final da
administração do bolus para efetuar a leitura da
bomba de insulina ou cancele o bolus e efetue depois
a leitura.

The device returned invalid entries; all data read will
be discarded. (O dispositivo enviou entradas inválidas;
todos os dados lidos serão eliminados.)

Contacte o seu representante local (consulte
Assistência na página 2).

Erros na criação de relatórios

Multiple data entries for the same date (Múltiplas entradas de dados para a mesma data)

Se o mesmo dispositivo apresentar várias entradas de dados para a mesma data e hora, o sistema

considera que existe um conflito insolúvel. Os relatórios criados com os dados deste dispositivo

omitirão a porção de dados sobrepostos.

Pode tentar ajustar o período abrangido pelo relatório para evitar os dados sobrepostos. Ou pode

retirar o dispositivo do sistema e adicioná-lo de novo para apagar as leituras anteriores.

System is going to ignore data (O sistema vai ignorar os dados)

Se a hora num dispositivo tiver sido alterada, causando sobreposições ou lacunas nos dados com

duração igual ou superior a três horas, o sistema não inclui essa porção de dados ao criar

relatórios.

Erros relativos a cópias de segurança e restauros

The database cannot be locked (Não é possível bloquear a base de dados)

Isto significa que está a usar o sistema num ambiente com vários utilizadores no qual existem

outros utilizadores com uma sessão iniciada. O sistema não permite que se efetue uma cópia de

segurança da base de dados enquanto outros utilizadores estiverem a realizar tarefas que possam

afetar a base de dados. Assim que todos os utilizadores saírem do CareLink Pro, poderá proceder

à cópia de segurança da base de dados.

A database backup or restore is not completing (Uma cópia de segurança ou restauro da
base de dados não está a ser completado)

Outros utilizadores não podem iniciar sessão e a cópia de segurança ou restauro não se

completam. Contacte o seu representante local (consulte Assistência na página 2).
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A restore database fails (O restauro da base de dados falhou)

O ficheiro com a cópia de segurança da base de dados que está a tentar utilizar no processo de

restauro está corrompido. Tente proceder ao restauro com outro ficheiro de cópia de

segurança.

Desinstalar o software

Se precisar de desinstalar o CareLink Pro, complete as seguintes etapas:

1 Abra o Painel de controlo através do menu Start  (Iniciar) do Windows.

2 Selecione Add or Remove Programs  (Adicionar ou remover programas). Abre-se a janela de

Adicionar ou remover programas do Windows.

3 Percorra a lista até Medtronic CareLink Pro  e clique neste nome.

4 Clique em Remove  (Remover). Surge o Assistente Install Shield.

5 Clique em Next  (Seguinte). Surge uma mensagem pedindo-lhe que confirme se pretende

remover a aplicação.

6 Clique em Yes  (Sim). O programa de desinstalação é executado e remove o programa e

respetivos ficheiros do seu computador. No final do processo, surge uma mensagem no ecrã

do Assistente confirmando a desinstalação.

7 Clique em Finish (Terminar).
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9

Tabela de ícones

Os ícones e símbolos dos rótulos da embalagem e do equipamento são descritos na tabela

seguinte:

Descrição Ícone

Um por contentor/embalagem (1X)

CD incluído

Ver instruções de utilização

Data de fabrico (ano)

Número de catálogo

Conformité Européenne (Conformidade Europeia). Este
símbolo significa que o dispositivo está em total
conformidade com a MDD 93/42/EEC.
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A

Dados CSV

Ao exportar dados de relatório a partir do software CareLink Pro, esses dados são exportados para

um ficheiro .csv. Este ficheiro pode ser posteriormente importado para uma aplicação de folha de

cálculo, como o Microsoft Excel. Consulte as definições de coluna do ficheiro CSV para obter uma

listagem completa dos dados que podem ser incluídos num ficheiro CSV.

O ficheiro CSV contém o nome do doente e respetiva ID, o período abrangido pelo relatório e

identifica cada dispositivo incluído no relatório.

Definições dos dados das colunas

Cabeçalho da coluna Definição

Index (Índice remissivo) A ordem pela qual os dados foram gravados no
dispositivo.

Date (Data) A data na qual os dados foram gravados no
dispositivo.

Time (Hora) A hora à qual os dados foram gravados no dispositivo.

New Device Time (Nova hora do dispositivo) A nova hora e data, se estas tiverem sido alteradas no
dispositivo.

BG Reading (mg/dL or mmol/L) (Leitura GS [mg/dl ou
mmol/l])

A leitura da glicose no sangue registada pelo medidor,
pelo Guardian ou pela bomba de insulina. Se os dados
forem provenientes de uma bomba de insulina ou do
Guardian, esta coluna reflete as GS manuais e as GS
recebidas de um medidor associado.

Linked BG Meter ID (ID de medidor de GS ligado)
Número de série do medidor de glicose que envia
uma leitura da glicose no sangue específica para o
dispositivo.

Basal Rate (U/h) (Índice basal [U/h]) O índice de administração de insulina basal ativa em
unidades por hora.

Temp Basal Amount (Quantidade do índice basal
temporário)

Se tiver sido aplicado um índice basal temporário na
bomba de insulina, este valor representa a quantidade
do índice basal temporário.

Temp Basal Type (Tipo de basal temporário) O tipo de ajuste do índice basal temporário (índice de
insulina ou percentagem de basal).

Temp Basal Duration (m) (Duração do índice basal
temporário [m])

A duração em minutos da administração da insulina
basal temporária (consulte o tipo acima referido).
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Cabeçalho da coluna Definição

Bolus Type (Tipo de bolus)
Tipo de administração de insulina de bolus (Normal,
Quadrada, Dupla [parte normal], ou Dupla [parte
quadrada]).

Bolus Volume Selected (U) (Volume de bolus
selecionado [U])

Número de unidades de insulina selecionadas para
administração durante a administração da insulina de
bolus.

Bolus Volume Delivered (U) (Volume de bolus
administrado [U])

Número de unidades de insulina efetivamente
administradas durante a administração da insulina de
bolus.

Programmed Bolus Duration (h) (Duração programada
do bolus [h])

Duração de um bolus quadrado ou da porção
quadrada de um bolus de onda dupla.

Prime Type (Tipo de enchimento)

Manual ou fixo. O manual é usado imediatamente
após uma rebobinagem, para encher o cateter de
infusão com insulina antes de o inserir. O fixo é usado
após a inserção do cateter de infusão, para encher a
cânula maleável com insulina após a remoção da
agulha introdutora.

Prime Volume Delivered (U) (Volume de enchimento
administrado [U])

Número de unidades de insulina efetivamente
administradas durante o enchimento.

Alarm (Alarme) Nome do alarme ocorrido.

Suspender Identifica o estado de suspensão da bomba de
insulina.

Rewind (Rebobinar) Data e hora em que o dispositivo foi rebobinado.

BWZ Estimate (U) (Estimativa do Bolus Wizard [U]) A estimativa da insulina de bolus calculada pela
função Bolus Wizard da bomba de insulina Paradigm.

BWZ Target High BG (mg/dL or mmol/L) (Objetivo
superior de GS do Bolus Wizard [mg/dl ou mmol/l])

Configuração do limite superior do intervalo de
objetivos de glicose no sangue, utilizado pela função
do Bolus Wizard.

BWZ Target Low BG (mg/dL or mmol/L) (Objetivo
inferior de GS do Bolus Wizard [mg/dl ou mmol/l])

Configuração do limite inferior do intervalo de
objetivos de glicose no sangue, utilizado pela função
do Bolus Wizard.

BWZ Carb Ratio (Taxa de hidratos de carbono do
Bolus Wizard)

Configuração para a taxa de hidratos de carbono/
insulina. Se as unidades usadas forem gramas, a taxa é
o número de gramas compensados por uma unidade
de insulina. Se as unidades usadas forem porções, a
taxa é o número de unidades de insulina utilizadas
para compensar uma porção de hidratos de carbono.

BWZ Insulin Sensitivity (Sensibilidade à insulina do
Bolus Wizard)

Configuração da sensibilidade à insulina. A
sensibilidade à insulina é a quantidade de glicose no
sangue reduzida com uma unidade de insulina. Esta é
utilizada pela função do Bolus Wizard.

BWZ Carb Input (Entrada de hidratos de carbono do
Bolus Wizard)

Quantidade de hidratos de carbono introduzida no
Bolus Wizard e utilizada para estimar um bolus.

BWZ BG Input (mg/dL or mmol/L) (Entrada de GS do
Bolus Wizard [mg/dl ou mmol/l])

Leitura da glicose no sangue quando introduzida no
Bolus Wizard e utilizada para estimar um bolus.

BWZ Correction Estimate (U) (Estimativa de correção
do Bolus Wizard [U])

Unidades de insulina de bolus a administrar para
corrigir o nível de glicose no sangue, conforme os
cálculos da função do Bolus Wizard.

BWZ Food Estimate (U) (Estimativa de alimentos do
Bolus Wizard [U])

Estimativa de unidades de insulina de bolus a
administrar para compensar as previsões de consumo
de hidratos de carbono, conforme os cálculos da
função Bolus Wizard.
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Cabeçalho da coluna Definição

BWZ Active Insulin (U) (Insulina ativa do Bolus Wizard
[U])

Cálculo da quantidade de insulina ativa proveniente
de administrações anteriores de insulina de bolus e
ainda presente no organismo, ao determinar a
estimativa da quantidade de bolus através da função
Bolus Wizard.

Sensor Calibration BG (mg/dL or mmol/L) (GS de
calibração do sensor [mg/dl ou mmol/l])

O valor de GS usado para calibrar o sensor em mg/dl
ou mmol/l.

Sensor Glucose (mg/dL or mmol/L) (Glicose do sensor
[mg/dl ou mmol/l]) O valor de glicose do sensor.

ISIG value (Valor ISIG) Sinais de entrada (ISIG), a serem lidos no sensor,
medidos em nanoamperes (nA).

Mais informações acerca dos ficheiros CSV exportados pelo CareLink
Pro

O título no topo dos ficheiros CSV inclui os seguintes dados:

• nome do doente;

• lista de dispositivos selecionados e respetivos números de série;

• intervalo de datas selecionado.
 
Cada bloco de colunas apresenta um título que inclui o seguinte:

• nome do dispositivo a que se refere o bloco de dados;

• número de série desse dispositivo.

Se os dados não forem visualizados conforme o previsto

São vários os fatores que podem fazer com que os dados dos CSV sejam visualizados de forma

diferente da prevista.

• As alterações da data ou hora no dispositivo podem influenciar a sequência dos registos ou

fazer com que sejam visualizados registos fora do intervalo de datas selecionado.

• Se existirem grandes intervalos entre leituras sucessivas do dispositivo, os dados podem ser

apresentados em vários blocos.
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Glossário

% da diferença média absoluta (Mean Absolute Difference ou MAD%) - Representa o nível de
exatidão na calibração entre as leituras de GS do sensor e do medidor. Quanto menor for este
número, maior será a exatidão da calibração. A MAD% é calculada a partir da diferença entre
pares de leituras de GS registadas pelo sensor e registadas pelo medidor em momentos
próximos, dividindo este valor pela leitura do medidor de glicose e achando a média de todos
os pares.

Análise da A1C - Análise da hemoglobina A1C, usada para interpretar o nível de glicose no sangue
ao longo de um período de tempo.

Análise da HbA1c - Análise da hemoglobina A1C, usada para interpretar o controlo da glicemia ou
a média de níveis ao longo de um período de 2 a 3 meses.

Área por baixo da curva ("Area Under the Curve" ou AUC) - Indica a quantidade de ocorrências
de níveis glicémicos elevados ou baixos, em referência a valores predefinidos. Os dados das
ocorrências indicam a frequência dos aumentos ou diminuições da glicose no sangue. A AUC
indica a magnitude dos eventos, mostrando o alcance e a duração do desvio.

Aviso de calibração - A bomba de insulina emitirá automaticamente, de 12 em 12 horas, um
alerta Medir GS até HH:MM, para indicar que o atual valor de calibração já não é válido. O valor
do aviso de calibração corresponde ao tempo que terá de decorrer antes do atual valor de
calibração expirar, quando o utilizador pretende ser recordado da necessidade de calibração.
Por exemplo, se a opção do aviso de calibração for configurada para 2 horas, o alerta Medir GS
até HH:MM será emitido 2 horas antes de a calibração ser necessária.

Aviso de nível baixo no reservatório - Aviso programável que notifica o utilizador com um alerta
quando resta no reservatório da bomba de insulina um número específico de unidades ou
quando resta uma determinada quantidade de tempo para o reservatório ficar vazio.

Bolus áudio - A bomba de insulina pode ser programada para que o utilizador ouça um sinal
sonoro ao selecionar uma quantidade de insulina de bolus (0,5 ou 1,0 unidade) para ser
administrada. Esta função é útil quando é difícil ver os botões da bomba de insulina.

Bolus de alimentação - Uma dose de insulina administrada para compensar a subida previsível da
glicose no sangue que ocorre após a ingestão de alimentos.

Bolus de correção - Quantidade de insulina necessária para restaurar os valores normais de
glicose no sangue em caso de um nível elevado.

Bolus de Onda Dupla (Dual Wave®) - Combinação de um bolus normal que é administrado
imediatamente, e seguido por um bolus de Onda Quadrada. A componente de Onda Quadrada
é administrada uniformemente ao longo de um período de tempo.

Bolus de Onda Quadrada (Square Wave®) - Bolus administrado uniformemente ao longo de um
período especificado de tempo (de 30 minutos a 8 horas).
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Bolus expresso - Método de administração de um qualquer tipo de bolus, usando o botão de
bolus expresso da bomba de insulina.

Bolus Fácil (Easy Bolus™) - Método de administração de um bolus normal com o botão Bolus Fácil
da bomba de insulina.

Bolus manual - Item opcional disponível no MENU BOLUS quando o Bolus Wizard está ativado.
Método de programar um bolus sem o Bolus Wizard.

Bolus máximo - A quantidade máxima de insulina de bolus que a bomba de insulina administrará
de uma só vez (definida pelo utilizador).

Bolus Normal - Administração imediata de uma quantidade especificada de unidades de insulina.

CareLink® Personal - Serviço online que permite a gestão dos dados da diabetes através da
Internet.

CH - Hidratos de carbono

ComLink - Dispositivo emissor-recetor de radiofrequência (RF) usado para transferir dados da
bomba de insulina Paradigm para o computador.

Componente de onda quadrada - A segunda parte de um bolus de Onda Dupla. A componente
de Onda Quadrada é administrada uniformemente ao longo de um período de tempo após a
administração da componente imediata.

Com-Station - Dispositivo utilizado para transferir dados da bomba de insulina MiniMed 508 e de
medidores capilares de outros fabricantes para o computador.

Concentração de insulina - Potência ou tipo da insulina que o médico prescreveu para o
utilizador. Esta afeta o índice de insulina administrado pela bomba de insulina. Se a
concentração de insulina do utilizador se alterar, será necessário reprogramar na bomba de
insulina os padrões basais e os índices máximos do bolus e basal.

Conjunto de infusão - Dispositivos usados para introduzir e fixar uma cânula sob a pele e para
transportar a insulina até ao local de inserção através de um tubo que parte da bomba de
insulina.

Dose de insulina basal - Uma infusão contínua de insulina administrada automaticamente por
hora por uma bomba de insulina, com base em perfis pré-programados e índices
personalizados definidos na bomba de insulina. A bomba de insulina administra uma infusão
diária de insulina que, geralmente, supre as necessidades de fundo durante períodos de jejum
(por exemplo, durante a noite e entre as refeições).

Enviar - Processo de transferência de dados da bomba de insulina ou medidor para o servidor
CareLink® Personal.

Etapa - Medida de insulina que é definida e usada pelo utilizador para administrar o Bolus Fácil.

Fator de bolus de correção - Valor da redução do seu nível de glicose no sangue conseguido com
1,0 unidade de insulina. Este fator é utilizado para calcular a quantidade de um bolus de
correção quando o seu nível de glicemia é elevado. (Nível de GS) - (Objetivo de GS) = X. X ÷
(Fator de bolus de correção) = Quantidade de bolus de correção

Função Padrões - Função alargada da bomba de insulina que permite programar índices basais
opcionais (Padrão A, Padrão B) que suportam atividades ou padrões glicémicos que não fazem
parte da rotina diária, mas que são habituais no estilo de vida do utilizador. Estas atividades
podem ser um desporto que o utilizador pratica uma vez por semana, uma mudança no padrão
de sono ao fim de semana ou alterações hormonais durante o ciclo menstrual.

Glicose baixa - A bomba de insulina emitirá um alarme se o sensor indicar que o nível de glicose
do utilizador é igual ou inferior a este valor. Dispõe da opção de ativar ou desativar esta função.

Glicose elevada - A bomba de insulina emitirá um alarme se o sensor indicar que o nível de
glicose do sensor do utilizador é igual ou superior a este valor. Dispõe da opção de ativar ou
desativar esta função.

GS - Abreviatura de glicose no sangue

HbA1c - Hemoglobina glicosada.

Hemoglobina A1C - Hemoglobina glicosada
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Hiperglicemia - Nível elevado de glicose no sangue demonstrado através da monitorização dos
níveis de glicemia na presença ou ausência dos seguintes sintomas: náuseas, vómitos, visão
turva, dores de cabeça, perturbações gástricas, micção frequente de grandes quantidades de
urina e letargia.

Hipoglicemia - Nível baixo de glicose no sangue demonstrado através da monitorização dos
níveis de glicose no sangue na presença ou ausência dos seguintes sintomas: fome excessiva,
tremores, transpiração, visão instável, sensação de cabeça vazia, dores de cabeça, dificuldades
na articulação da fala, alterações súbitas de humor ou de personalidade.

Identificação do transmissor (ID transm) - Indica o número de série do transmissor que está a ser
utilizado.

Índice basal - Configuração da bomba de insulina que permite uma infusão de insulina contínua
de modo a manter a estabilidade da glicose no sangue entre refeições e durante a noite. A
insulina basal imita a administração de insulina pelo pâncreas que supre todas as necessidades
de insulina do corpo não relacionadas com a ingestão de alimentos.

Índice basal temporário (basal temp) - Insulina basal temporária única com uma quantidade e
duração especificadas. Utilizada para suprir as necessidades de insulina para atividades ou
condições especiais que não fazem parte da rotina diária normal.

Insulina basal máxima - A quantidade máxima de insulina basal que a bomba de insulina
administrará de uma só vez (definida pelo utilizador).

Insulina de bolus - Uma dose de insulina administrada para compensar uma subida previsível da
glicemia (como acontece após uma refeição ou lanche) ou para baixar uma glicemia elevada
até valores normais.

ISIG - Valores do sensor que indicam se os componentes eletrónicos do transmissor num sistema
acrescido de sensor estão a funcionar corretamente. Se observar um valor ISIG inferior a 24,00
nA ou superior a 29,00 nA, contacte a assistência ao produto. Pode ter chegado o momento de
substituir o seu transmissor.

Ligação
(1) Ligação para ativar e configurar a opção do medidor que permite à bomba de insulina
receber as leituras de GS de um medidor que comunica com a bomba de insulina.
(2) É ainda usada neste sistema como sinónimo de hiperligação. Ao clicar na ligação de
hipertexto, o utilizador é levado a outro ponto no sistema ou a outro sítio da Web.

Medidor - Dispositivo médico para determinar a concentração aproximada da glicose no sangue.
Uma pequena gota de sangue é colocada numa tira de teste descartável; o medidor de glicose
no sangue efetua a leitura da tira e usa esta leitura para calcular o nível de glicemia. O medidor
mostra então o nível em mg/dl ou mmol/l.

Opção do medidor - Função que permite à bomba de insulina receber leituras de GS a partir de
um medidor de GS ligado.

Padrão standard - O padrão basal normal que suporta a sua atividade diária habitual. Quando a
função Padrões está desativada, a bomba de insulina utiliza o seu padrão standard (basal).

Padrões basais - Os utilizadores podem programar até três padrões diferentes de índice basal na
sua bomba de insulina para a administração da insulina basal: Padrão, A e B. Para cada padrão, é
possível configurar até 48 índices basais.

Perfil basal - Índice basal com hora de início e de fim. Os utilizadores podem programar vários
perfis diferentes na bomba de insulina, cada um dos quais com um índice basal diferente,
durante um período de 24 horas, para obter um melhor controlo da glicose no sangue.

RF - Radiofrequência (RF).

Sensibilidade à insulina - Quantidade em mg/dl (ou mmol/l) da redução do seu nível de glicose
no sangue (GS) conseguida com uma unidade de insulina (Dados do Bolus Wizard).

Suspender - Função que interrompe toda a administração de insulina pela bomba de insulina.
Todas as atuais administrações de bolus e/ou enchimentos são cancelados. A administração do
índice basal é colocada em pausa até ser retomada.

Taxa carb (Taxa de hidratos de carbono) - A quantidade de hidratos de carbono compensada
por uma unidade de insulina (Ver também Taxa porção).
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Taxa prç (Taxa de porções) - Quantidade de insulina necessária para compensar uma (1) porção
de hidratos de carbono. (ver também Taxa carb).

Temp - Temporário.

Teste às cetonas - As cetonas são resíduos produzidos no corpo quando este é forçado e queimar
gordura em vez de glicose para obter energia. Pode ser um sinal de falta de insulina no corpo. A
análise às cetonas mede a quantidade de cetonas concentradas no sangue ou urina.

Unidades de hidratos de carbono - A ingestão de alimentos ao utilizar Bolus Wizard. Introduzida
como gramas ou porções (de hidratos de carbono).
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